Legal Notices

Novell, Inc. makes no representations or warranties with respect to the contents or use of this documentation, and specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc. reserves the right to revise this publication and to make changes to its content, at any time, without obligation to notify any person or entity of such revisions or changes.

Further, Novell, Inc. makes no representations or warranties with respect to any software, and specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc. reserves the right to make changes to any and all parts of Novell software, at any time, without any obligation to notify any person or entity of such changes.

Any products or technical information provided under this Agreement may be subject to U.S. export controls and the trade laws of other countries. You agree to comply with all export control regulations and to obtain any required licenses or classification to export, re-export or import deliverables. You agree not to export or re-export to entities on the current U.S. export exclusion lists or to any embargoed or terrorist countries as specified in the U.S. export laws. You agree to not use deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses. For more information on exporting Novell software, see the Novell International Trade Services Web page (http://www.novell.com/info/exports/). Novell assumes no responsibility for your failure to obtain any necessary export approvals.

Copyright © 2003-2010 Novell, Inc. All rights reserved. No part of this publication may be reproduced, photocopied, stored on a retrieval system, or transmitted without the express written consent of the publisher.

Novell, Inc.
1800 South Novell Place
Provo, UT 84606
U.S.A.
www.novell.com

Online Documentation: To access the latest online documentation for this and other Novell products, see the Novell Documentation Web page (http://www.novell.com/documentation).

Novell Trademarks

For Novell trademarks, see the Novell Trademark and Service Mark list (http://www.novell.com/company/legal/trademarks/tmlist.html).

Third-Party Materials

All third-party trademarks are the property of their respective owners.
## Contents

### About This Guide

#### 1 Getting Started

1.1 Prerequisites ................................. 11
1.2 Starting GroupWise WebAccess .......................... 11
1.3 Understanding Timing Out from GroupWise WebAccess ........................................ 12
1.4 Changing Your Password .................................. 13
1.5 Getting to Know the GroupWise WebAccess Interface ........................................ 13
  1.5.1 Understanding the Nav Bar ................................... 13
  1.5.2 Understanding the Toolbar ................................ 14
1.6 Exploring the Folder List .............................. 14
  1.6.1 Home Folder ..................................... 15
  1.6.2 Mailbox Folder ..................................... 15
  1.6.3 Unopened Items ..................................... 15
  1.6.4 Sent Items Folder .................................... 15
  1.6.5 Calendar Folder ..................................... 15
  1.6.6 Contacts Folder ..................................... 15
  1.6.7 Tasklist Folder ..................................... 16
  1.6.8 Work in Progress Folder ............................. 16
  1.6.9 Cabinet Folder ..................................... 16
  1.6.10 Junk Mail Folder ..................................... 16
  1.6.11 Trash Folder ..................................... 16
  1.6.12 Shared Folders ..................................... 17
  1.6.13 GroupWise Feeds Folder ............................ 17
1.7 Understanding GroupWise Item Types ...................... 17
  1.7.1 Mail ........................................... 17
  1.7.2 Appointment ....................................... 17
  1.7.3 Task ............................................ 18
  1.7.4 Note ............................................. 18
  1.7.5 Phone Message .................................... 18
1.8 Identifying the Icons Appearing Next to Items ................. 18
1.9 Learning More .................................... 19
  1.9.1 Online Help ....................................... 19
  1.9.2 GroupWise 8 Documentation Web Page .......................... 19
  1.9.3 GroupWise Cool Solutions Web Community ................. 20

#### 2 Getting Organized

2.1 Using Categories to Organize Items ................... 21
  2.1.1 Assigning a Category ................................ 21
  2.1.2 Adding a New Category ............................. 21
  2.1.3 Removing a Category from an Item .................... 22
  2.1.4 Renaming a Category ............................... 22
  2.1.5 Deleting a Category ................................ 22
2.2 Using Folders to Organize Your Mailbox .................. 22
  2.2.1 Understanding Folders .............................. 22
  2.2.2 Modifying the Folder List ........................... 23
  2.2.3 Deleting Folders .................................... 23
  2.2.4 Creating a Personal Folder .......................... 23
  2.2.5 Renaming a Folder ................................... 24
  2.2.6 Moving an Item to Another Folder .................... 24
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.4.4 Moving an Appointment to a Different Calendar</td>
<td>59</td>
</tr>
<tr>
<td>4.5 Publishing Personal Calendars on the Internet</td>
<td>59</td>
</tr>
<tr>
<td>4.5.1 Publishing a Personal Calendar</td>
<td>60</td>
</tr>
<tr>
<td>4.5.2 Modifying a Published Calendar’s Settings</td>
<td>60</td>
</tr>
<tr>
<td>4.5.3 Unpublishing a Calendar</td>
<td>60</td>
</tr>
<tr>
<td>4.5.4 Publishing Your Free/Busy Schedule</td>
<td>61</td>
</tr>
<tr>
<td>4.6 Printing a Calendar</td>
<td>61</td>
</tr>
<tr>
<td>5 Tasks and the Tasklist</td>
<td>63</td>
</tr>
<tr>
<td>5.1 Understanding Tasks</td>
<td>63</td>
</tr>
<tr>
<td>5.2 Understanding the Tasklist Folder</td>
<td>63</td>
</tr>
<tr>
<td>5.3 Using Tasks</td>
<td>64</td>
</tr>
<tr>
<td>5.3.1 Assigning a Task</td>
<td>64</td>
</tr>
<tr>
<td>5.3.2 Tracking Task Completion</td>
<td>66</td>
</tr>
<tr>
<td>5.4 Using the Tasklist Folder</td>
<td>66</td>
</tr>
<tr>
<td>5.4.1 Moving an Item from Another Folder to the Tasklist Folder</td>
<td>66</td>
</tr>
<tr>
<td>5.4.2 Assigning a Due Date to a Tasklist Item</td>
<td>67</td>
</tr>
<tr>
<td>5.4.3 Reordering the Tasklist Folder</td>
<td>67</td>
</tr>
<tr>
<td>6 Contacts and Address Books</td>
<td>69</td>
</tr>
<tr>
<td>6.1 Understanding Address Books</td>
<td>69</td>
</tr>
<tr>
<td>6.1.1 GroupWise Address Book</td>
<td>69</td>
</tr>
<tr>
<td>6.1.2 Frequent Contacts Address Book</td>
<td>70</td>
</tr>
<tr>
<td>6.1.3 Personal Address Books</td>
<td>70</td>
</tr>
<tr>
<td>6.2 Using the Address Books to Address Items</td>
<td>70</td>
</tr>
<tr>
<td>6.2.1 Using the Address Selector</td>
<td>70</td>
</tr>
<tr>
<td>6.2.2 Sending Mail from the Address Book</td>
<td>72</td>
</tr>
<tr>
<td>6.3 Using the Contacts Folder</td>
<td>72</td>
</tr>
<tr>
<td>6.3.1 Managing Contacts</td>
<td>72</td>
</tr>
<tr>
<td>6.3.2 Managing Groups</td>
<td>74</td>
</tr>
<tr>
<td>6.3.3 Managing Resources</td>
<td>76</td>
</tr>
<tr>
<td>6.3.4 Managing Organizations</td>
<td>77</td>
</tr>
<tr>
<td>6.3.5 Using Frequent Contacts to Address an Item</td>
<td>78</td>
</tr>
<tr>
<td>6.4 Working with Address Books</td>
<td>79</td>
</tr>
<tr>
<td>6.4.1 Opening an Address Book</td>
<td>79</td>
</tr>
<tr>
<td>6.4.2 Creating a Personal Address Book</td>
<td>79</td>
</tr>
<tr>
<td>6.4.3 Editing a Personal or Frequent Contacts Address Book</td>
<td>80</td>
</tr>
<tr>
<td>6.4.4 Deleting a Personal Address Book</td>
<td>80</td>
</tr>
<tr>
<td>6.4.5 Accepting a Shared Address Book</td>
<td>81</td>
</tr>
<tr>
<td>6.4.6 Viewing Contacts, Groups, Organizations, or Resources in an Address Book</td>
<td>81</td>
</tr>
<tr>
<td>6.4.7 Searching for Address Book Entries</td>
<td>82</td>
</tr>
<tr>
<td>7 Finding Items</td>
<td>83</td>
</tr>
<tr>
<td>7.1 Understanding GroupWise Searches</td>
<td>83</td>
</tr>
<tr>
<td>7.2 Searching for a Word or Phrase Using Find</td>
<td>84</td>
</tr>
<tr>
<td>7.3 Searching with Criteria</td>
<td>84</td>
</tr>
<tr>
<td>7.4 Narrowing a Search</td>
<td>84</td>
</tr>
<tr>
<td>7.5 Viewing the Results of a Search</td>
<td>85</td>
</tr>
<tr>
<td>7.6 Finding Text in Items</td>
<td>85</td>
</tr>
<tr>
<td>8 Rules</td>
<td>87</td>
</tr>
<tr>
<td>8.1 Understanding Rules</td>
<td>87</td>
</tr>
<tr>
<td>8.2 Actions a Rule Can Perform</td>
<td>87</td>
</tr>
</tbody>
</table>
About This Guide

This Novell GroupWise 8 WebAccess Client User Guide explains how to use the GroupWise WebAccess client. It is divided into the following sections:

- Chapter 1, “Getting Started,” on page 11
- Chapter 2, “Getting Organized,” on page 21
- Chapter 3, “E-Mail,” on page 29
- Chapter 4, “Calendar,” on page 49
- Chapter 5, “Tasks and the Tasklist,” on page 63
- Chapter 6, “Contacts and Address Books,” on page 69
- Chapter 7, “Finding Items,” on page 83
- Chapter 8, “Rules,” on page 87
- Chapter 9, “Mailbox/Calendar Access for Proxies,” on page 93
- Chapter 12, “Maintaining GroupWise,” on page 101
- Appendix A, “What’s New In GroupWise 8 WebAccess,” on page 105
- Appendix C, “Using Shortcut Keys,” on page 111

Audience

This guide is intended for GroupWise users.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation included with this product. Please use the User Comments feature at the bottom of each page of the online documentation, or go to www.novell.com/documentation/feedback.html and enter your comments there.

Documentation Updates

For the most recent version of the GroupWise 8 WebAccess Client User Guide, visit the Novell GroupWise 8 documentation Web site (http://www.novell.com/documentation/gw8).

Additional Documentation

For additional GroupWise documentation, see the following guides at the Novell GroupWise 8 documentation Web site (http://www.novell.com/documentation/gw8):

- Installation Guide
- Administration Guide
Getting Started

GroupWise is a robust, dependable messaging and collaboration system that connects you to your universal mailbox anytime and anywhere. This section gives you an overview of the GroupWise WebAccess client to help you start using GroupWise quickly and easily.

- Section 1.1, “Prerequisites,” on page 11
- Section 1.2, “Starting GroupWise WebAccess,” on page 11
- Section 1.3, “Understanding Timing Out from GroupWise WebAccess,” on page 12
- Section 1.4, “Changing Your Password,” on page 13
- Section 1.5, “Getting to Know the GroupWise WebAccess Interface,” on page 13
- Section 1.6, “Exploring the Folder List,” on page 14
- Section 1.7, “Understanding GroupWise Item Types,” on page 17
- Section 1.8, “Identifying the Icons Appearing Next to Items,” on page 18
- Section 1.9, “Learning More,” on page 19

1.1 Prerequisites

- Any of the following Web browsers:
  - Linux: Mozilla Firefox 2.0 or later
  - Windows: Microsoft Internet Explorer 6.0 or later; Mozilla Firefox 2.0 or later
  - Macintosh: The latest version of Safari for your version of Mac OS; Mozilla Firefox 2.0 or later

- Any mobile device that supports Wireless Access Protocol (WAP) and has a microbrowser that supports Hypertext Markup Language (HTML) 4.0 or later, or Wireless Markup Language (WML) 1.1 or later

1.2 Starting GroupWise WebAccess

You start GroupWise WebAccess as you would any other home page on the Internet.

To log in to WebAccess:

1. Use your Web browser to go to the URL your administrator gives you, such as http://server/gw/webacc, or an IP address such as 155.155.11.22.
2 On the GroupWise WebAccess login page, enter your username and password.

3 Select your connection speed:
   - High (Broadband), which has all the features that are available in GroupWise WebAccess. Use this default setting if you have a high-speed Internet connection.
   - Low (Dial-up), which looks the same as the default high-speed interface but does not auto-update your message list and calendar. It also does not support name completion.

4 (Conditional) If you're using a mobile device, select Use the basic interface. The basic interface has limited functionality and graphics. It is designed to perform the most basic tasks in GroupWise WebAccess. To close the basic interface, close all Web browsers and launch WebAccess again, making sure to deselect Use the basic interface.

5 (Optional) If you use the same browser to log in to GroupWise WebAccess every time, select Remember My Settings to save your preferences.

6 Click Login.
   Your GroupWise mailbox opens.

1.3 Understanding Timing Out from GroupWise WebAccess

Specific actions, such as opening or sending an item, generate a call to the Web server. Other actions, such as scrolling through items in the Item List, composing a message without sending it, or reading Help topics, do not generate a call to the Web server. If, for a period of time, you leave GroupWise WebAccess alone or perform actions that do not generate a call, WebAccess logs you out. Doing so provides security for your e-mail and ensures that the Web server and GroupWise WebAccess run efficiently.

The default timeout period is 20 minutes. However, your GroupWise administrator can change the timeout period for your organization's GroupWise system. If you try to perform an action after you have been logged out, you are prompted to log in again.

To ensure that you have the latest information in your Mailbox and to prevent frequent timeouts, click Update.

NOTE: You must authenticate correctly to be returned to your work after a timeout. If you haven't logged in correctly, the message you were composing might appear to be lost. Use the keyboard to return to your saved message window (for example, Alt+Left-arrow key in Windows).
1.4 Changing Your Password

In order to access your GroupWise mailbox from WebAccess, your mailbox must have a password. Your GroupWise administrator might have assigned the password when he or she set up your GroupWise account. If you have access to the GroupWise Windows client, you can set your initial mailbox password yourself, as described in “Assigning a Password to Your Mailbox” in “Getting Started” in the *GroupWise 8 Windows Client User Guide*.

To change your mailbox password in WebAccess:

1. Click *Options > Password*.
2. Type your new password twice for confirmation.
3. Click *Save*, then click *Close*.

Depending on the security level that your GroupWise administrator has established for your post office, you might need to know more about passwords. For more information, see Section 12.1, “Managing Mailbox Passwords,” on page 101.

1.5 Getting to Know the GroupWise WebAccess Interface

Your main work area in GroupWise is called the Main Window. From the Main Window of GroupWise, you can read your messages, schedule appointments, view your Calendar, manage contacts, open folders, and much more.

- Section 1.5.1, “Understanding the Nav Bar,” on page 13
- Section 1.5.2, “Understanding the Toolbar,” on page 14

1.5.1 Understanding the Nav Bar

The Nav Bar is located at the top of the WebAccess page. It is designed for quick access to the folders you use the most. By default the Nav Bar contains the Mailbox, Calendar, Contacts, and Documents folders.

*Figure 1-1 The GroupWise WebAccess Nav Bar*
1.5.2 Understanding the Toolbar

Use the toolbar to access many of the features and options found in WebAccess. The toolbar at the top of a folder or item is context sensitive; it changes to provide the options you need most in that location.

There are two different toolbars you can display:

- **Main**: The Main Toolbar contains most of your commonly used functions, such as New Appointment and New Mail. The Main Toolbar is located at the top of the main page.
- **Item Context**: The Item Context toolbar contains context-sensitive buttons that relate to the item that is displayed. The Item Context toolbar is located at the top of the page.

![The GroupWise WebAccess Main Toolbar](image)

1.6 Exploring the Folder List

The Folder List at the left of the Main Window lets you organize your GroupWise items by creating folders to store your items in. The Mailbox folder is the default folder that is opened when you first log in. For information about the different GroupWise folders, see Section 2.2, “Using Folders to Organize Your Mailbox,” on page 22.

The following folders are displayed in the Folder List:

- [Section 1.6.1, “Home Folder,” on page 15](#)
- [Section 1.6.2, “Mailbox Folder,” on page 15](#)
- [Section 1.6.3, “Unopened Items,” on page 15](#)
- [Section 1.6.4, “Sent Items Folder,” on page 15](#)
- [Section 1.6.5, “Calendar Folder,” on page 15](#)
- [Section 1.6.6, “Contacts Folder,” on page 15](#)
- [Section 1.6.7, “Tasklist Folder,” on page 16](#)
1.6.1 Home Folder

Your Home folder (indicated by your name) represents your GroupWise database. All folders in your Folder List are subfolders of your Home folder.

1.6.2 Mailbox Folder

The Mailbox displays all the items you have received, with the exception of scheduled items (appointments, tasks, and reminder notes) you have accepted or declined. By default, scheduled items and tasks are moved to the Calendar when you accept them.

Your received items are stored in your GroupWise Mailbox.

You can organize your messages by moving them into folders within your Cabinet, and you can create new folders as necessary.

1.6.3 Unopened Items

The Unopened Items folder lists received items you have not yet opened. It is a query folder that cannot be deleted.

1.6.4 Sent Items Folder

The Sent Items folder displays all the items you have sent. By checking the properties of your sent items, you can determine their status (Delivered, Opened, and so on).

1.6.5 Calendar Folder

The Calendar folder shows several calendar view options. It is basically a link that takes you to the Calendar view. You can use the Folder List to choose which calendars to display. The selected calendars are displayed in the calendar view.

1.6.6 Contacts Folder

The Contacts folder, by default, represents the Frequent Contacts address book. Any modification you make in the Contacts Folder is also made in the Frequent Contacts address book.

From this folder, you can view, create, and modify contacts, resources, organizations, and groups.
1.6.7 Tasklist Folder

Use the Tasklist folder to create a task list. You can move any items (mail messages, phone messages, reminder notes, tasks, or appointments) to this folder and arrange them in the order you want.

1.6.8 Work in Progress Folder

The Work In Progress folder is a folder where you can save messages you have started but want to finish later. This is also where all Auto Save messages are automatically saved.

1.6.9 Cabinet Folder

The Cabinet contains all of your personal folders. You can rearrange and nest folders by clicking Manage Folders on the Toolbar.

1.6.10 Junk Mail Folder

All e-mail items from addresses and Internet domains that are janked through Junk Mail Handling are placed in the Junk Mail folder. This folder is not created in the folder list unless a Junk Mail option is enabled.

While Junk Mail options are enabled, this folder cannot be deleted. However, the folder can be renamed or moved to a different location in the folder list. If all Junk Mail options are disabled, the folder can be deleted. The folder can also be deleted if the Junk Mail Handling feature is disabled by the system administrator.

To delete items from the Junk Mail folder, right-click the Junk Mail folder, click Empty Junk Mail Folder, then click Yes.

For more information about Junk Mail Handling, see Section 3.6, “Handling Unwanted E-Mail (Spam),” on page 47.

1.6.11 Trash Folder

All deleted mail and phone messages, appointments, tasks, documents, and reminder notes are stored in the Trash folder. Items in the Trash can be viewed, opened, or returned to your Mailbox before the Trash is emptied. (Emptying the Trash removes items in the Trash from the system.)

You can empty your entire Trash, or empty only selected items. The system administrator can specify that your Trash is emptied automatically on a regular basis.
1.6.12 Shared Folders

A shared folder is like any other folder in your Cabinet, except other people have access to it. You can create shared folders or share existing personal folders in your Cabinet. You choose whom to share the folder with, and what rights to grant each user. Users can post messages to the shared folder, drag existing items into the folder, and create discussion threads. You can’t share system folders, which include the Cabinet, Trash, and Work In Progress folders.

If you place a document in a shared folder, people with rights to the shared folder don’t automatically have rights to edit the document. Before they can edit the document, you must give them Edit rights on the Manage Folders > Share Folder tab.

1.6.13 GroupWise Feeds Folder

When you subscribe to RSS feeds, the GroupWise Feeds folder is created. A list of subscribed feeds is displayed under the GroupWise Feeds folder. You can create subfolders under the GroupWise Feeds folder and move feeds to the subfolder. When you click the subfolder, the message list displays a list of all the topics for all the feeds under the subfolder.

Although you cannot subscribe to new RSS feeds in WebAccess, you can view the feeds you subscribed to and downloaded in the GroupWise Windows client.

For additional information on RSS feeds, see Section 10, “RSS Feeds,” on page 97.

1.7 Understanding GroupWise Item Types

Every day you communicate in a variety of ways. To accommodate these needs, GroupWise delivers your items by using a variety of item types. Each item type is explained below.

- Section 1.7.1, “Mail,” on page 17
- Section 1.7.2, “Appointment,” on page 17
- Section 1.7.3, “Task,” on page 18
- Section 1.7.4, “Note,” on page 18
- Section 1.7.5, “Phone Message,” on page 18

1.7.1 Mail

A mail message is for basic correspondence, such as a memorandum or letter. See Section 3.3, “Receiving E-Mail,” on page 42 and Section 3.1, “Sending E-Mail,” on page 29.

1.7.2 Appointment

An appointment lets you invite people to and schedule resources for meetings or events. You can schedule the date, time, and location for the meeting. You can use posted appointments to schedule personal events such as a doctor’s appointment, a reminder to make a phone call at a certain time, and so forth. Appointments display on the Calendar. See Section 4.3.2, “Scheduling Appointments,” on page 54.
1.7.3 **Task**

A task lets you place a to-do item on your own or on another person’s Calendar after it has been accepted. You can schedule a due date for the task and include a priority (such as A1). Uncompleted tasks are carried forward to the next day. See Section 5.3.1, “Assigning a Task,” on page 64.

**TIP:** You can also create a Tasklist that is not associated with your Calendar. In this type of Tasklist, any item type (mail, appointment, task, reminder note, phone message) can be used.

1.7.4 **Note**

A note is posted on a specific date on your own or another person’s Calendar. You can use notes to remind yourself or others of deadlines, holidays, days off, and so forth. Posted notes are useful as reminders for birthdays, vacations, paydays, and so forth. See Section 4.3.3, “Sending Reminder Notes,” on page 57.

1.7.5 **Phone Message**

A phone message helps you inform someone of a phone call or visitor. You can include such information as caller, phone number, company, urgency of the call, and so forth. You cannot answer your phone from a phone message. See Section 3.1.11, “Sending a Phone Message,” on page 38.

1.8 **Identifying the Icons Appearing Next to Items**

The icons that appear next to items in your Mailbox, Sent Items folder, and the Calendar show information about the items. The following table explains what each icon means.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✎</td>
<td>One or more attachments are included with the item.</td>
</tr>
<tr>
<td></td>
<td>Draft item.</td>
</tr>
<tr>
<td>🔄</td>
<td>An item you have sent.</td>
</tr>
<tr>
<td>🔄</td>
<td>An item you have replied to.</td>
</tr>
<tr>
<td>🔄</td>
<td>An item you have forwarded.</td>
</tr>
<tr>
<td>🔄</td>
<td>An item you have delegated.</td>
</tr>
<tr>
<td>✎</td>
<td>An item you have replied to and forwarded</td>
</tr>
<tr>
<td>✎</td>
<td>An item you have replied to and delegated.</td>
</tr>
<tr>
<td>✎</td>
<td>An item you have forwarded and delegated.</td>
</tr>
<tr>
<td>✎</td>
<td>An item you have replied to, forwarded, and delegated.</td>
</tr>
</tbody>
</table>
1.9 Learning More

You can learn more about GroupWise from the following resources:

- Section 1.9.1, “Online Help,” on page 19
- Section 1.9.2, “GroupWise 8 Documentation Web Page,” on page 19
- Section 1.9.3, “GroupWise Cool Solutions Web Community,” on page 20

1.9.1 Online Help

Complete user documentation is available in Help. In the Main Window, click Help, then use the Contents tab, Index tab, or Search tab to locate the help topics you want.

1.9.2 GroupWise 8 Documentation Web Page

For a complete set of GroupWise user and GroupWise administration documentation, go to the GroupWise 8 Documentation Web site (http://www.novell.com/documentation/gw8).
1.9.3 GroupWise Cool Solutions Web Community

At the Cool Solutions Web site (http://www.novell.com/communities/coolsolutions/gwmag), you’ll find tips, tricks, feature articles, and answers to frequent questions.
In *Getting Started*, you learned the basics of the GroupWise environment. Now, in “*Getting Organized*”, you learn how to transform the basic GroupWise environment into an efficient, customized collaboration environment that suits your personal work style.

- Section 2.1, “Using Categories to Organize Items,” on page 21
- Section 2.2, “Using Folders to Organize Your Mailbox,” on page 22
- Section 2.3, “Customizing Other GroupWise WebAccess Functionality,” on page 26

## 2.1 Using Categories to Organize Items

Categories are used to help define and prioritize items in your mailbox. Categories apply a color pattern of your choice to the specified e-mail messages, so you can classify them at a glance. You can assign more than one category to an item, but one category is always primary and displays the primary color scheme. Categories also apply to calendar items and can be added to calendar items the same way they are added to mail items.

- Section 2.1.1, “Assigning a Category,” on page 21
- Section 2.1.2, “Adding a New Category,” on page 21
- Section 2.1.3, “Removing a Category from an Item,” on page 22
- Section 2.1.4, “Renaming a Category,” on page 22
- Section 2.1.5, “Deleting a Category,” on page 22

### 2.1.1 Assigning a Category

1. Select the message you want to add a category to.
2. Right-click and select *Categories*.
3. Select the category you want to use.
4. Click *OK*.

### 2.1.2 Adding a New Category

1. Click .
2. Fill in a name under *New Category*.
3. Click *Add*.
4. Select the category from the list and specify the text and background colors.
2.1.3 Removing a Category from an Item

1. Select the item you want to remove the category from.
2. Right-click and select Categories.
3. Deselect the box to the left of the category.
4. Click OK.

2.1.4 Renaming a Category

1. Click .
2. Select the category you want to rename.
3. Click Rename.
4. Specify the new name, then click OK.

2.1.5 Deleting a Category

1. Click .
2. Select the category you want to remove.
3. Click Delete.

2.2 Using Folders to Organize Your Mailbox

Use folders to store and organize your items. For example, you can group all items related to a particular task or subject together.

- Section 2.2.1, “Understanding Folders,” on page 22
- Section 2.2.2, “Modifying the Folder List,” on page 23
- Section 2.2.3, “Deleting Folders,” on page 23
- Section 2.2.4, “Creating a Personal Folder,” on page 23
- Section 2.2.5, “Renaming a Folder,” on page 24
- Section 2.2.6, “Moving an Item to Another Folder,” on page 24
- Section 2.2.7, “Understanding Find Results Folders,” on page 24
- Section 2.2.8, “Using Shared Folders,” on page 24

2.2.1 Understanding Folders

The Folder List displays the folders that are relative to the folder you are currently in. The following are context-sensitive Folder Lists:

- Calendar: Displays a list of all calendars. From here you can select to display the contents of a calendar in the main calendar. In addition, you can change the color of a calendar.
- Contacts: Displays a list of all personal address books. By default, the main Contacts folder is the Frequent Contacts address book.
- Documents: Displays a list of your document libraries. By default, the main Documents folder is your default document library.
Click + and - to expand and collapse folders.

For information about the individual folders you might have in your Folder List, see Section 1.6, “Exploring the Folder List,” on page 14.

You can organize items in your folders by moving them. When you move an item into a folder, it is taken from one location and placed in another.

You can store unfinished items in a predefined folder called Work In Progress (see “Saving an Unfinished E-Mail” on page 34). You can also make folders public by sharing them (see “Using Shared Folders” on page 24). You can create rules to automatically sort items to different folders (see Section 8.3, “Creating a Rule,” on page 88).

### 2.2.2 Modifying the Folder List

1. On the main WebAccess page, click **Manage Folders** on the toolbar.

   ![Manage Folders Window]

   In the Manage Folders window, you can create, delete, and share folders.

### 2.2.3 Deleting Folders

1. Right-click the folder you want to delete, then click **Delete Folder**.
2. Click **OK**.

You cannot delete the Calendar, Mailbox, Sent Items, Tasklist, Contacts, Cabinet, Work In Progress, or Trash folders. You can delete the Junk Mail folder only if Junk Mail Handling has been disabled.

### 2.2.4 Creating a Personal Folder

1. On the main WebAccess page, click **Manage Folders** on the toolbar.
2. Select the place in the Folder List where you want to add the folder. By default, a new folder is added as the first folder in the Cabinet.

   For example, to add a folder at the same level as the Mailbox folder, click the **Down** button next to the Mailbox folder. To add a folder to the Mailbox folder, click the **Right** button next to the Mailbox folder.

3. Type a name for your new folder in the **Folder Name** field.
4. Click **Add Folder**.
2.2.5 Renaming a Folder

In some cases you might want to rename a folder to more accurately reflect the contents of a folder or to correct a spelling error. In WebAccess new folders can be created but names of existing folders cannot be changed. You can change folder names in the GroupWise Windows client.

For more information on managing folders, see Section 2.2.1, “Understanding Folders,” on page 22.

2.2.6 Moving an Item to Another Folder

1. Locate the item in the Item List.
2. Double-click the item to open it, then click the Move icon.
3. Click the folder where you want to move the item.

If you are moving the item to a folder in the Cabinet, you might need to click the plus sign (+) next to the Cabinet to display the Cabinet folders.

2.2.7 Understanding Find Results Folders

A Find Results folder is a folder that displays the results of a query. When the folder is opened, GroupWise examines the search criteria defined for the folder, searches for everything specified, then displays everything it finds in the Item List. You can act on items in a Find Results folder the same way you act on items in any folder, such as opening, forwarding, printing, copying, moving, or deleting them, but the original item remains stored in the folder where the search found it. This means that if you move or delete an item from a Find Results folder, the item is deleted from the Item List, but not from the original location. The next time you open the Find Results folder, the search is performed again and the item is once again displayed.

Although you cannot create new Find Results folders in WebAccess, you can use folders you created in the GroupWise Windows client. However, to ensure that you are viewing the most recent information in the folder and not a cached copy, you should click Update in the toolbar before opening a Find Results folder.

2.2.8 Using Shared Folders

A shared folder is like any other folder in your Cabinet, except other people have access to it and it appears in their Cabinets. You can create shared folders or share existing personal folders in your Cabinet. You choose whom to share the folder with, and what rights to grant each user. Then, users can post messages to the shared folder, drag existing items into the folder, and create discussion threads. You cannot share system folders, which include the Mailbox, Unopened Items, Sent Items, Calendar, Task List, Checklist, Cabinet, Work In Progress, Junk Mail, and Trash folders.

If you place a document in a shared folder, people with rights to the shared folder can read the document, but they don't automatically have rights to edit. Before they can edit the document, you must give them Edit rights on the Share Folder tab.

You can share personal folders with other users. Recipients of the shared folder receive a notification explaining that you have shared the folder with them. They can then accept the folder or decline the folder.

• “Sharing an Existing Folder with Other Users” on page 25
• “Accepting a Shared Folder” on page 25
Sharing an Existing Folder with Other Users

1. On the main WebAccess page, click Manage Folders, then click the Share Folder tab.
2. Select the folder you want to share. Folders available for sharing are underlined.

3. In the Name box, start typing the name of a user.
   or
   Click Address Book to select the user in the Address Book window.
4. Select the access options you want for the user.
5. Repeat Step 3 through Step 4 for each user you want to share the folder with.
6. Click Save.

Accepting a Shared Folder

1. Click the Shared Folder notification in your Mailbox.
2. Click Accept Folder.
3. The name of the folder is filled in by default. Make any desired changes to the name of the folder.
4. Select the folder’s location.
5. Click Finish.

Posting an Item to a Shared Folder

1. In the Folder List, open the shared folder you want to post the item to.
2. At the top of the Item List, click Post to display a Message form.
3. Type a subject and message.
You can include Web site locations or addresses (URLs) in both the Subject and Message fields.

4 (Optional) Click Spell Check to spell check the message.

5 (Optional) Click Attach to attach files to the message. For this feature to work, your browser must support attachments.

6 Click Post to add the message to the shared folder.

Deleting a Shared Folder

To delete a folder that is shared with you:

1 Right-click the folder.
2 Click Delete.
3 Click Yes.

Deleting a folder that is shared with you just deletes the folder from your GroupWise Mailbox. All other users are unaffected. However, if you are the one who shared the folder with others, then deleting that folder removes it from all other users as well.

2.3 Customizing Other GroupWise WebAccess Functionality

This section discusses how to customize the look and feel of GroupWise.

- Section 2.3.1, “Setting the Default Compose View,” on page 26
- Section 2.3.2, “Changing Your Time Zone,” on page 27

2.3.1 Setting the Default Compose View

To change the view for all items:

1 On the main WebAccess page, click Options in the upper right corner.
2 Click the Compose tab.
3 In the Default Compose View box, select Plain Text or HTML.
4 Click Save, then click Close.

To change the view in one item:

1 Open an item.
2 Click the HTML or Plain Text icon.
2.3.2 Changing Your Time Zone

GroupWise WebAccess automatically adjusts the time for appointments sent between people in different time zones. For example, if you are located in New York and schedule a conference call in Los Angeles for 4:00 p.m. your time, the appointment received by the Los Angeles recipients shows the conference call at 1:00 p.m. their time.

By default, GroupWise WebAccess uses the time zone established for your GroupWise post office. However, if you are using GroupWise WebAccess in a time zone other than your post office's time zone, you should change your time zone setting.

The GroupWise WebAccess time zone setting applies only to GroupWise WebAccess. If you have access to the GroupWise Windows client, that client uses the time zone configured through the Windows operating system, not the time zone you set in GroupWise WebAccess.

1. On the main WebAccess page, click Options in the upper right corner.
2. Click the Time Zone tab.
3. Select to use either your workstation's time zone or select the time zone you want to use from the drop-down menu.
4. Click Save, then click Close.
An e-mail item is basically a text message sent to a recipient. In GroupWise, an e-mail item can be a message, appointment, task, reminder note, or a phone message note. You can write them in plain text or HTML, and you can add attachments to them. All incoming items are delivered to your Mailbox folder.

- Section 3.1, “Sending E-Mail,” on page 29
- Section 3.2, “Managing Sent E-mail,” on page 39
- Section 3.3, “Receiving E-Mail,” on page 42
- Section 3.4, “Managing Received E-Mail,” on page 46
- Section 3.5, “Printing E-Mail,” on page 47
- Section 3.6, “Handling Unwanted E-Mail (Spam),” on page 47

### 3.1 Sending E-Mail

When you send an e-mail message from GroupWise WebAccess, you can send the message either as text or HTML. Additionally, you can choose to attach a file, add a signature to the message, and spell check the message before it is sent.

The address book and name completion help you to quickly and easily find the contacts you need when sending an e-mail message.

- Section 3.1.1, “Composing E-Mail,” on page 30
- Section 3.1.2, “Formatting Messages,” on page 30
- Section 3.1.3, “Spell-Checking Messages,” on page 31
- Section 3.1.4, “Attaching Files,” on page 32
- Section 3.1.5, “Adding a Signature,” on page 32
- Section 3.1.6, “Saving Unfinished E-Mail,” on page 33
- Section 3.1.7, “Selecting the Default Compose View,” on page 35
- Section 3.1.8, “Addressing Mail Messages,” on page 35
- Section 3.1.9, “Selecting Send Options,” on page 36
- Section 3.1.10, “Posting a Note,” on page 38
- Section 3.1.11, “Sending a Phone Message,” on page 38
3.1.1 Composing E-Mail

1. Click New on the toolbar.
2. In the To box, type a username, then press Enter. As you begin to type, the system automatically tries to match the name and complete it for you. Repeat for additional users. If necessary, type usernames in the CC and BC boxes.

   or

   To select usernames from a list, click Address Book on the toolbar, search for and select each user, click To, CC, or BC for each user, then click OK.

3. Type a subject.
4. Type a message.

   You can specify many options, such as making this message a high priority, requesting a reply from the recipients, and more, by clicking the Send Options tab.

   When you use the Categories option, only the four default categories carry over to the recipient.

5. Include any attachments by clicking the Attachments tab on the toolbar.
6. Click Send on the toolbar.

3.1.2 Formatting Messages

When sending a message, you can select from several format options. You can select to send the message as a text or HTML message, and you can change the fonts, colors, and layout of the message.

- “Changing the Font in the HTML View” on page 30
- “Formatting Bulleted and Numbered Lists” on page 31
- “Undoing the Last Text Action” on page 31

Changing the Font in the HTML View

The recipient of an item sees the changes you make in Plain Text view if he or she views the item in Plain Text view. The recipient of an item sees the changes you make in HTML view if he or she views the item in HTML view. You might want to let the recipient know which view you composed the item in.

1. In an open item you are composing, make sure the HTML toolbar is displayed.

2. Use the HTML toolbar to change the font, add background colors, add images, and more.
You might need to resize the item view horizontally to see all the buttons on the HTML toolbar.

**Formatting Bulleted and Numbered Lists**

You can easily include bulleted and numbered lists in messages.

1. In an open item you are composing in the HTML view, use the HTML toolbar to insert a bulleted or numbered list.
2. Type the list item, then press Enter to create the next item in the list.
3. Press Enter twice after the last item to turn off the list formatting.

**Undoing the Last Text Action**

You can undo the last text action in the *Subject* or *Message* field of a message you are composing.

1. Click *Edit > Undo*.

You can also undo an action by pressing Ctrl+Z. (For information about other shortcut keys, see Appendix C, “Using Shortcut Keys,” on page 111.)

**3.1.3 Spell-Checking Messages**

Spell Checker lets you check for misspelled words in the messages you create. It checks for misspelled words, duplicate words, and irregular capitalization in items you are creating.

When Spell Checker finds a misspelled word, you can replace it with a word Spell Checker suggests, edit the word manually, or skip the word.

You use the compose options to set up Spell Checker to automatically spell check your messages before you send them.

- “Spell-Checking an Item with Spell Checker” on page 31
- “Spell-Checking Items Automatically with Spell Checker” on page 32
- “Selecting the Spell Checker Language” on page 32

**Spell-Checking an Item with Spell Checker**

1. Click the *Subject* or *Message* field.
2. Click *Check Spelling*.
   
   WebAccess highlights any misspelled words.
3. Click any highlighted word.
4. Select one of the words Spell Checker suggests to replace the misspelled word.
   
   or
   
   Click *Edit* to make your own corrections.
5. Click *Resume Editing* when spell-checking is complete.
Spell-Checking Items Automatically with Spell Checker

You can spell-check items automatically every time you click Send.

1. On the main WebAccess page, click Options in the upper right corner.
2. Click the Compose tab.
3. Select Check spelling before send.
4. Click Save, then click Close.

Selecting the Spell Checker Language

1. Click the Subject field or the Message field.
2. Click the drop-down menu next to Check Spelling.
3. Select the language to use.

3.1.4 Attaching Files

Use the Attachments tab to send one or more files to other users. You can attach files that exist on your hard disk, diskette, or network drive to an item you are sending. The recipients can open the attached file, save it, view it, or print it. If you change the attached file after you have sent it, the recipients do not see the changes.

If you attach a file that is password-protected, the recipient cannot open or view the attachment without entering the password.

1. Open a new item.
2. Fill in the To, Subject, and Message fields.
3. Click the Attachments tab, then browse to and select the file or files you want to send.
4. Click Attach.
   - To remove an attached file, click the attachment, then click Remove.
5. Click Send on the toolbar.

Moving or deleting a file on a disk or network drive does not affect a file you attached to an item and sent.

If you delete an attached file, it is not erased from disk or network drive; it is simply removed from the attachment list.

3.1.5 Adding a Signature

Use Signatures to insert a signature or tag line at the end of items you send. For example, you can have WebAccess automatically list your name, phone number, and e-mail address at the bottom of every item you send.

In addition to personal signatures, your system administrator can create a global signature for everyone to use. If the system administrator requires the global signature, it is automatically appended to all items that are sent. When you resend an item, the global signature is not automatically added to the message.
Signatures that you have already set up in the GroupWise Windows client are not automatically transferred to the GroupWise WebAccess client. You must re-create the signature in the WebAccess client.

1. On the main WebAccess page, click Options in the upper right corner.
2. Click Compose.
3. Click Enable signature.
4. Type your signature text in the box.
5. Click Automatically Add Signature to have WebAccess automatically add your signature when you send the item.
   or
   Click Prompt before adding signature to have WebAccess prompt you to add the signature when you send the item.
6. Click Save, then click Close.

3.1.6 Saving Unfinished E-Mail

- “Understanding Auto-Save“ on page 34
- “Saving an Unfinished E-Mail” on page 34
Understanding Auto-Save

When you compose a new message in GroupWise WebAccess, items are automatically saved for you. This prevents the loss of any messages you are authoring if WebAccess unexpectedly shuts down. When you restart WebAccess, you have the option to recover these messages to finish composing them.

If you stop using GroupWise WebAccess for 10 seconds (the default non-use value) and have unsent messages or if you have been actively composing messages for 60 seconds (the default continuous use value), WebAccess automatically saves your messages to your Work In Progress folder. WebAccess adds two characters to the title of all auto-saved messages to distinguish them from other items you might have manually saved to your Work In Progress folder.

Your administrator can disable the auto-save feature and change the non-use and continuous values. When you start WebAccess, if there are auto-saved messages, the following window is displayed:

Figure 3-1  Auto-Save Window

You have the following options to deal with auto-saved messages:

Open: Opens the auto-saved messages so that you can finish composing them.

Save: Saves the messages as regular Work In Progress items so that you can finish composing the messages later.

Delete: Deletes the auto-saved messages. The information in them is permanently lost.

Skip: Retains the saved messages on disk but does not recover them in WebAccess. The next time you start WebAccess, the Auto-Save window reappears.

Enabling or Disabling Auto-Save

By default, Auto-Save is enabled if you use a high-speed connection to access your GroupWise system. It is disabled by default if you use a low connection speed. For more information on your login options for connecting, see Section 1.2, “Starting GroupWise WebAccess,” on page 11.

1  On the main WebAccess page, click Options in the upper right corner.
2  Click the Compose tab.
3  Select Enable auto-save to enable Auto-Save.
   or
   Deselect Enable auto-save to disable Auto-Save.
4  Click Save, then click Close.

Saving an Unfinished E-Mail

1  In an open item, click the Save icon.
2  Click the folder you want to save the item to, then click OK.
The draft message is placed in the folder you chose in Step 2. The default folder for unfinished messages is the Work In Progress folder.

### 3.1.7 Selecting the Default Compose View

When you are composing a message in GroupWise WebAccess, you can select to have the default compose format in either plain text or HTML.

1. On the main WebAccess page, click *Options* in the upper right corner.
2. Click the *Compose* tab.
3. Select either *Plain text* or *HTML* in the *Message Format* section.
4. Click *Save*, then click *OK*.

### 3.1.8 Addressing Mail Messages

A mail message has a primary recipient, a subject line, and can be carbon copied and blind copied to other users. You can also attach files, document references, sounds, movies, and OLE objects to your mail messages.

- “Using the Address Book” on page 35
- “CC (Carbon Copy)” on page 35
- “BC (Blind Copy)” on page 35
- “Adding Addresses to Mail Messages” on page 35

#### Using the Address Book

For information on using the Address Book, see Chapter 6, “Contacts and Address Books,” on page 69.

#### CC (Carbon Copy)

Carbon copy recipients (CC) receive a copy of an item. CC recipients are users who would benefit from the information in an item, but are not affected by or directly responsible for it. All recipients can see that a carbon copy was sent. They can also see the names of the CC recipients.

#### BC (Blind Copy)

Blind copy recipients (BC) receive a copy of an item. Other recipients receive no information about blind copies. Only the sender and the blind copy recipient know that a blind copy was sent. If a recipient replies and chooses *Reply to All*, the blind copy recipient does not receive the reply.

#### Adding Addresses to Mail Messages

1. Click *New* on the toolbar.
2. In the *To* field, type a username, then press Enter. Repeat for additional users. If necessary, type usernames in the *CC* and *BC* fields.

   or

   To select usernames from a list, click *Address Book* on the toolbar, search for and select each user, then click *OK.*
3 Type a subject.

4 Type a message.

You can specify many options, such as making this message a high priority, requesting a reply from recipients, and more, by clicking the Send Options tab.

If you want, you can change the font of the message text. For information, see “Changing the Font in the HTML View” on page 30.

5 Include any attachments by clicking the Attachments tab.

6 Click Send on the toolbar.

3.1.9 Selecting Send Options

- “Changing the Priority of Mail You Send” on page 36
- “Changing the Security Setting (Classification) of All Items You Send” on page 37
- “Changing the MIME Encoding of a Message” on page 37

Changing the Priority of Mail You Send

1 To change the priority of one item, open an item, then click the Send Options tab.

or

To change the priority of all items you send, click Options in the right corner of the main WebAccess page, then click the Send Options tab.

2 Select High, Standard, or Low.

The small icon next to an item in the Mailbox is red when the priority is high, white when the priority is standard, and gray when the priority is low.

3 Click Save, then click Close.
Changing the Security Setting (Classification) of All Items You Send

A classification is a security setting that lets the recipient know if the item is confidential, top secret, and so forth. This information appears at the top of the item. A classification does not provide any encryption or additional security. It is meant to alert the recipient to the relative sensitivity of the item.

1. On the main WebAccess page, click Options in the upper right corner.
2. Click the Send Options tab.

3. Select a security setting from the Classification drop-down list.
4. Click Save, then click Close.

Changing the MIME Encoding of a Message

Many languages require different character encodings to display certain characters properly. In GroupWise WebAccess, you can change the encoding for items that you send and receive.

- “Changing the Encoding for All Items You Send” on page 37
- “Changing the Encoding for One Item” on page 38

Changing the Encoding for All Items You Send

1. On the main WebAccess page, click Options in the upper right corner.
2. Click the Send Options tab.
3. Select your MIME encoding from the MIME Encoding drop-down list.
4. Click Save, then click Close.
Changing the Encoding for One Item

1. In the Mail Message window, click the Send Options tab.
2. Select your MIME encoding from the MIME Encoding drop-down list.
3. Click Send on the toolbar to send the message.

3.1.10 Posting a Note

A note is a message that is posted to your mailbox only. Notes are a way of creating personal notes for yourself.

1. On the main WebAccess page, click the arrow next to New, then click Posted Note.
2. Type a subject.
3. Type a message.
4. Include any attachments by clicking Attachments on the toolbar.
5. Click Post on the toolbar.

3.1.11 Sending a Phone Message

A phone message is a note you can send to notify other GroupWise users of calls they received while they were out of the office or unavailable. Phone messages are stored in the recipient’s Mailbox. You cannot answer your phone from a phone message.

1. On the main WebAccess page, click the arrow next to New, then click Phone.

2. In the To field, type a username, then press Enter. Repeat for additional users. If necessary, type usernames in the CC and BC fields.
   
or
   To select usernames from a list, click Address Book on the toolbar, search for and select each user, then click OK.
3. Type the name, company, and phone number of the caller.
4. Type the message in the Message field.
If you want, you can change the font of the message text. For information, see “Changing the Font in the HTML View” on page 30.

Click Send on the toolbar.

3.2 Managing Sent E-mail

- Section 3.2.1, “Working with Sent Items,” on page 39
- Section 3.2.2, “Retracting Sent E-Mail,” on page 39
- Section 3.2.3, “Resending E-Mail,” on page 39
- Section 3.2.4, “Checking the Status of Sent E-Mail,” on page 40
- Section 3.2.5, “Confirming Delivery of E-Mail You Send,” on page 41
- Section 3.2.6, “Displaying Sent Items,” on page 42

3.2.1 Working with Sent Items

You might want to display items you previously sent. For example, you can read a sent item, resend it with or without corrections, and in some cases, retract it (if it has not already been opened by the recipient).

1. Click the Sent Items folder in the Folder List.

All sent items reside in this folder unless they are moved to a folder other than the Mailbox or Calendar. If a sent item is moved to another folder, it no longer displays in the Sent Items folder. To display sent items that have been moved to other folders, open those folders.

3.2.2 Retracting Sent E-Mail

Use Delete from All Mailboxes to retract a sent item from the recipient’s Mailbox. You can retract a mail or phone message from those recipients who haven’t yet opened the item. You can retract an appointment, reminder note, or task at any time. However, items that have been sent out across the Internet to other e-mail systems cannot be retracted.

1. Click the Sent Items folder in the Folder List.
2. Select the item you want to retract, then click Delete From All Mailboxes.
3. Click OK.

To see which recipients have opened your message, right-click the item, then click Properties. E-mail cannot be retracted if it has already been opened.

3.2.3 Resending E-Mail

Use Resend to send an item a second time, perhaps with corrections.

1. Click the Sent Items folder in the Folder List.
2. Right-click and select Resend.
3. Make any changes to the item, if necessary, then click Send on the toolbar.
4. Select Retract Original Item? if you want to retract the original item.
You can check the properties of the original item to see if GroupWise was able to retract it. Right-click the item in the *Sent Items* folder, then click *Properties*. Mail and phone messages cannot be retracted if they have already been opened.

### 3.2.4 Checking the Status of Sent E-Mail

If the receiver’s e-mail system enables status tracking, you can receive status information about the items you send. The Properties window lets you check the status of any item you’ve sent. For example, you can see when an item was delivered and when the recipient opened or deleted the item. If a recipient accepted or declined an appointment and included a comment, you’ll see the comment in the Properties window. You also see if a recipient marked a task completed.

The Properties window also shows information about items you receive. You can see who else received the item (except for blind copy recipients), the size and creation date of attached files, and more.

- “Status Overview” on page 40
- “Checking the Status of an Item” on page 40
- “Saving the Status Information of an Item” on page 40
- “Printing the Status Information of an Item” on page 41

#### Status Overview

There are two views for the properties:

- **Basic Properties:** Displays the Properties header and a list of recipients. The list of recipients displays the recipient’s name, what actions the recipient has taken with the item, the date and time of the last action, and any comments.
- **Advanced Properties:** Displays the Properties header, recipients, post offices, files, and options for the item. The Advanced Properties page is helpful to system administrators when they need to track the item for troubleshooting purposes.

You can save and print status information for an item.

#### Checking the Status of an Item

1. Right-click an item in your Mailbox or Calendar, then click *Properties*.

The icons next to an item can also give you helpful status information. For more information, see Section 1.8, “Identifying the Icons Appearing Next to Items,” on page 18.

To change to the Advanced Properties, click *Advanced Properties*.

#### Saving the Status Information of an Item

1. Right-click an item, then click *Properties*.
2. Click *File > Save Page As*.
   
   WebAccess gives the item a temporary filename. You can change the filename and default folder.
3. Click *Save*. 
Printing the Status Information of an Item

1. Right-click an item, then click Properties.
2. Click to display a printer-friendly version of the status information.
3. Select print options and print the status page as you normally would in your Web browser.

3.2.5 Confirming Delivery of E-Mail You Send

GroupWise WebAccess provides several ways to confirm that your item was delivered.

- “Tracking Sent Items” on page 41
- “Receiving Notification About Items You Send” on page 41
- “Requesting a Reply for Items You Send” on page 41

Tracking Sent Items

You can check the status in the Properties window of any item you send. For information, see “Checking the Status of Sent E-Mail” on page 40.

Receiving Notification About Items You Send

If the receiving e-mail system is capable of returning notifications, you can receive notification when the recipient opens or deletes a message, declines an appointment, or completes a task.

1. To get a return receipt for one item, open an item view, then click the Send Options tab.
   or
   To always receive notification for items you send, click Options in the right corner of the main WebAccess page, then click the Send Options tab.
2. In the Return Notification section, specify the type of return receipt you want.
3. Click Save.

Requesting a Reply for Items You Send

You can inform the recipient of an item that you need a reply. GroupWise WebAccess adds a sentence to the item stating that a reply is requested and changes the icon in the recipient’s Mailbox to a double arrow.

1. To request a reply for one item, open an item view, then click the Send Options tab.
   or
   To request a reply for all items you send, click Options in the right corner of the main WebAccess page, then click the Send Options tab.
2. Specify when you want to receive the reply.
The recipient sees next to the message. If you select When Convenient, “Reply Requested: When convenient” appears at the top of the message. If you select Within x Days, “Reply Requested: By xx/xx/xx” appears at the top of the message.

3 Click Save.

3.2.6 Displaying Sent Items

You might want to display items you previously sent. For example, you can read a sent item, resend it with or without corrections, and in some cases, retract it (if it has not already been opened by the recipient).

1 Click the Sent Items folder in the folder list.

All sent items reside in this folder unless they are moved to a folder other than the Mailbox or Calendar. If a sent item is moved to another folder, it no longer displays in the Sent Items folder. To display sent items that have been moved to other folders, open those folders.

3.3 Receiving E-Mail

GroupWise uses the Mailbox to store all the mail messages, appointments, and other items you receive.

- Section 3.3.1, “Reading Received Items,” on page 43
- Section 3.3.2, “Reading Attachments,” on page 44
- Section 3.3.3, “Replying to E-Mail,” on page 45
- Section 3.3.4, “Forwarding E-Mail to Other People,” on page 46
3.3.1 Reading Received Items

You can read items you receive in your Mailbox or Calendar. Your Mailbox displays a list of all of the items you have received from other users. Posted appointments, tasks, and reminder notes appear in your Calendar, not in your Mailbox.

You can open and read all types of new items in your Mailbox. However, you might want to read tasks and reminder notes in your Calendar so you can view new messages while looking at your schedule.

Phone and mail messages stay in your Mailbox until you delete them. Appointments, reminder notes, and tasks stay in your Mailbox until you accept, decline, or delete them. When you accept an appointment, reminder note, or task, it is moved to your Calendar.

All Mailbox items are marked with an icon. The icons change depending on whether or not the item has been opened. See Section 1.8, “Identifying the Icons Appearing Next to Items,” on page 18 for more information.

All unopened items in your Mailbox are bolded to help you easily identify which items and documents you have not yet read.

- “Reading Items” on page 43
- “Setting the View for One Item” on page 43
- “Marking an Item Read Later” on page 43
- “Marking an Item Read” on page 44

Reading Items

Messages are automatically displayed in the format in which they were sent. Messages display in your browser’s default font and size.

To read a message:

1 Double-click the message in the Message list to view the message in a new window.

NOTE: For security reasons, images are not displayed by default in HTML messages. To view the images, click GroupWise has prevented images on this page from displaying. Click here to display the images.

Setting the View for One Item

You can change the view for one item only if that item is composed in HTML.

1 Open an item.
2 Click either the Plain Text or HTML button on the toolbar.

Marking an Item Read Later

If you open an item to read it, and then decide you want to read the item later, you can mark the item read later. Marking the item read later changes the item to bold and changes the item’s icon to unopened so you know you still need to read the item.

1 In the Mailbox, click the item in the Item List.
2 Click Read Later at the top of the Item List.
If you have opened an item, marking it read later does not change the status of the item in Properties. For example, if you have opened an item, then marked the item read later, the sender of the item still sees the item status as opened in the Properties window.

**Marking an Item Read**

1. In the Mailbox, click the item in the Item List.
2. Click *Mark Read at* the top of the Item List.

Marking an item read changes the status of the item in Properties. For example, if you have not opened an item, but you marked the item read, the sender of the item sees the item status as opened in the Properties window.

### 3.3.2 Reading Attachments

GroupWise WebAccess can send and receive attachments with items. When you receive an attachment with an item, the list of attachments is under the subject.

- “Viewing Attached Files” on page 44
- “Saving Attached Files” on page 44
- “Opening Attached Files” on page 44
- “Printing Attached Files” on page 45

**Viewing Attached Files**

When you view an attached file, the attachment is displayed in the message pane with a viewer. This is usually faster than opening the attachment; however, the attachment might not be formatted properly. If the attachment type is not supported, *View* is not displayed.

1. Open the item containing the attachment.
2. Click *View* next to the attachment.

**Saving Attached Files**

When you have an attached file, GroupWise WebAccess allows you to save the file to another location.

1. Open the item containing the attachment.
2. Click *Save As* next to the attachment.
3. Select a location to save the attachment.

**Opening Attached Files**

When you open an attached file, GroupWise WebAccess determines the correct application to open the file in. You can accept the suggested application, or you can select the path and filename to another application.

1. Open the item containing the attachment.
2. Click *Open* next to the attachment.
Printing Attached Files

1. In an open message, click View or Open to see the contents of the attached file.
2. Click File > Print in your Web browser if you are viewing the file.
   or
   Use the native application to print the file if you opened it.

3.3.3 Replying to E-Mail

Use Reply to respond to an item. You can reply to everyone who received the original item or to the sender only, without creating and addressing a new message. You can also include a copy of the original message in your reply. Your reply includes Re: preceding the original subject text. You can modify the subject text if you want.

- “Replying to an E-Mail” on page 45
- “Modifying Your Compose Settings” on page 45

Replying to an E-Mail

1. Open the item you want to reply to.
2. Click Reply on the toolbar to send the e-mail just to the sender.
   or
   Click Reply All on the toolbar to send the e-mail to the sender and all recipients.
3. Type your message, then click Send on the toolbar.

If the original item included BC or CC recipients and you selected to reply to all, your reply is sent to the CC recipients but not to the BC recipients.

Modifying Your Compose Settings

1. On the main WebAccess page, click Options in the upper right corner.
2. Click the Compose tab.
3. Select Enable auto save if you want to enable the Auto Save feature.
4. Select the Spell Checking options you want, including:
   - Check spelling before send
   - Default language
5. Select the default Compose view you want, either Plain Text or HTML.
   Your administrator can turn off the HTML format option.
6. Select the signature options you want.
7. Click Save, then click Close.
3.3.4 Forwarding E-Mail to Other People

Use Forward to send items you receive to other users. When you forward an item, it is sent as an attachment to a mail message. The mail message includes your name and any additional comments you have made.

1. Right-click the item you want to forward.
2. Click Forward on the toolbar.
3. Add the names of the users to whom you want to forward the item.
4. (Optional) Type a message.
5. Click Send on the toolbar.

If you can't accept an appointment, task, or reminder note, you can delegate the item instead of forwarding it. Delegating places a Delegated status in the item's Properties window, letting the sender know you have transferred responsibility for the item to another person.

3.4 Managing Received E-Mail

• Section 3.4.1, “Saving an Item to Disk,” on page 46
• Section 3.4.2, “Saving Status Information,” on page 46
• Section 3.4.3, “Deleting E-Mail,” on page 47
• Section 3.4.4, “Viewing the Source of External Messages,” on page 47

3.4.1 Saving an Item to Disk

Saved items remain in your Mailbox and Calendar as well as being copied to the location you specify.

1. Open the item you want to save.
2. Click File > Save Page As.
3. Type a name for the file.
4. Select the location from the Save in folder drop-down menu
   or
   Select Browse for other folders to browse for a different location.
5. Click Save.

3.4.2 Saving Status Information

1. Right-click an item, then click Properties.
2. Click File > Save Page As.
   GroupWise WebAccess gives the item a temporary filename. You can change the filename and default folder.
3. Click Save.
3.4.3 Deleting E-Mail

Use Delete to remove selected items from your Mailbox. You can also use Delete to retract items you have sent. You can retract mail and phone messages if the recipients have not read them or if they have not been sent to the Internet. You can retract appointments, reminder notes, and tasks at any time.

If you receive junk mail that requires frequent manual deletion, you might want to set up Junk Mail Handling. For more information, see “Handling Unwanted E-Mail (Spam)” on page 47.

1 On the main WebAccess page, select one or more items, then click Delete.
   Deleted items are moved to your Trash and remain there until the Trash is emptied.

3.4.4 Viewing the Source of External Messages

When you receive or send messages to and from external systems, you can view the source for a message. The source includes all the data that is contained in a message.

1 Open an item that you received from an external source.
2 Click View next to the Mime.822 attachment to open it.

3.5 Printing E-Mail

When you print an item, the From, To, Date, Subject, CC, and attachment names are displayed at the top of the page.

1 In an open item, click to open a printer-friendly view of the item.

   IMPORTANT: Do not use File > Print in your Web browser. The graphical version of the item displayed in WebAccess cannot be printed as it displays on the screen.

2 Click Print this page.
3 Select print options and print as you normally would from your Web browser.

3.6 Handling Unwanted E-Mail (Spam)

Use Junk Mail Handling to decide what to do with unwanted Internet e-mail, also known as spam, that is sent to your GroupWise e-mail address.

- Section 3.6.1, “Understanding Junk Mail Handling,” on page 47
- Section 3.6.2, “Blocking or Junking E-Mail,” on page 48

3.6.1 Understanding Junk Mail Handling

Internet e-mail includes all e-mail where the sender’s address is in the form of name@example.com, name@example.org, and so forth. Internal e-mail is e-mail where the sender is part of your GroupWise system and the From field shows only the name of the sender, not an Internet address.

An Internet domain is the part of the e-mail address that comes after the @. For example, in the address Henry@example.com, the Internet domain is example.com.
For information about the Junk Mail folder, see “Junk Mail Folder” on page 16.

Your system administrator can turn off Junk Mail Handling so that it is not available.

### 3.6.2 Blocking or Junking E-Mail

If you want to block or junk internal e-mail, you can use rules. (For more information, see Section 8.3, “Creating a Rule,” on page 88.) For example, you can create a Delete rule that moves all items from a specific e-mail address or entire Internet domains to your Trash folder. Or you can use the following procedure to create a Move to Folder rule that moves items with a specified subject to your Junk Mail folder.

1. On the main WebAccess page, click *Options* in the upper right corner.
2. Click *Rules*.
3. Select *Move to Folder* from the drop-down menu of the *Type* field, then click *Create*.
4. Type a name in the *Rule name* field, such as Junk Mail Rule.
5. Use Define Conditions to add specific information to your rule.
   - In the first condition field, select *From*.
   - In the second condition field, select *Matches*.
   - In the last condition field, type the name of the person or a specific Internet domain as it displays in the *From:* field of a mail message. For example: msmith@corporate.com or @corporate.com.
6. Select the Junk Mail folder as the destination folder.
7. Click *Save*.
8. Verify that the check box is selected next to the rule you just created, then click *Close*. 
4 Calendar

You can view your schedule in a variety of views or formats, including day, week, and month. For example, the month view lets you view a month schedule, and the tasks section allows you to see all of your posted tasks arranged by their due dates. For more information about Tasks, see Chapter 5, “Tasks and the Tasklist,” on page 63.

- Section 4.1, “Understanding the Calendar,” on page 49
- Section 4.2, “Managing Your Calendar,” on page 49
- Section 4.3, “Sending Calendar Items,” on page 54
- Section 4.4, “Receiving Calendar Items,” on page 58
- Section 4.5, “Publishing Personal Calendars on the Internet,” on page 59
- Section 4.6, “Printing a Calendar,” on page 61

4.1 Understanding the Calendar

You can have multiple calendars that display in your calendar view. You can create a unique color for each calendar, making it quickly identifiable in the calendar view. You can share each calendar or all calendars with other users.

Many types of calendar views and printouts are available to let you choose the one that displays the information you need. The view you selected for your last session is used as your default view the next time you log in to GroupWise WebAccess.

You can open the Calendar from the Nav Bar or from the Calendar folder in the Main Window.

If you need to set how your work schedule displays the times that you are available for appointments, use the GroupWise Windows client to set your work schedule. Then you can use the WebAccess client to view your work schedule.

4.2 Managing Your Calendar

- Section 4.2.1, “Viewing Your Calendar,” on page 50
- Section 4.2.2, “Reading a Calendar Entry,” on page 52
- Section 4.2.3, “Creating a Personal Calendar,” on page 52
- Section 4.2.4, “Using Shared Calendars,” on page 53
4.2.1 Viewing Your Calendar

There are several different ways to view your GroupWise calendar, including by day, week, and month.

All unaccepted items in your Calendar are italicized to help you easily identify which items you have not yet accepted.

- “Opening the Calendar Folder or a Calendar View” on page 50
- “Selecting Calendars to Display” on page 51
- “Viewing a Different Date in the Calendar” on page 51
- “Viewing All Day Events in the Calendar” on page 51
- “Navigating in the Calendar” on page 51
- “Understanding Calendar Shading” on page 51

Opening the Calendar Folder or a Calendar View

The Calendar tab in the Nav Bar has a toolbar that provides access to several view options. The view that is displayed when you exit your Calendar displays when you open the Calendar folder again.

1. In the Nav Bar, click Calendar, then click the buttons on the Calendar toolbar to choose different views.

You can view the Calendar in various formats, including day, week, and month. To see another view, click a different button on the Calendar toolbar.
Selecting Calendars to Display

GroupWise WebAccess has the ability to display multiple calendars in the main GroupWise Calendar. You can select to view your main GroupWise Calendar, personal calendars, and shared calendars.

1. In the Calendar view, select the calendar check box next to the calendars you want to display.

Viewing a Different Date in the Calendar

1. Click a date in the date picker calendar at the bottom left corner of the Calendar view.
   Today’s date is in bold.

The arrows in the left corner move you back or ahead one month, and the arrows in the right corner move you back or ahead one year in most languages.

Viewing All Day Events in the Calendar

All day events are located at the top of the calendar in the All Day Events pane in the Day and Week views.

![All Day Events Pane](image)

Navigating in the Calendar

Use the Calendar toolbar to navigate in your calendar.

1. To select a date to view, click a date in the Calendar at the bottom left corner of your calendar view.
2. To return to today’s date, click .
3. To move forward or back one day, one week, or one month, depending upon what the calendar display is set to, click .
4. To see a day view, click Day on the Calendar toolbar.
5. To see a week view, click Week on the Calendar toolbar.
6. To see a month view, click Month on the Calendar toolbar.

Understanding Calendar Shading

Appointments on your calendar appear in different shades, depending on how the appointment is shown:

- **Busy**: The appointment displays as gray.
- **Free**: The appointment displays as white.
- **Out of the Office**: The appointment displays as dark gray.
- **Tentative**: The appointment displays as gray with white and gray stripes on the side.
To change an appointment’s *Show Appointment As* status:

1. Open the appointment, then click *Busy, Free, Tentative, Out of Office, or Tentative* from the *Show As* drop-down menu.

### 4.2.2 Reading a Calendar Entry

1. In the Nav Bar, click *Calendar*.
2. Double-click the item you want to read.

In all Calendar views, you can rest your mouse pointer on most items and see more information such as Subject, Time, Place, and To.

### 4.2.3 Creating a Personal Calendar

1. In a Calendar view, click the arrow next to *New* on the toolbar, then click *Calendar*.
2. Type a name for the new calendar.
3. (Optional) Type a description for the calendar.
4. (Optional) Select a color for the calendar by clicking a colored square.
5. Click *Save*, then click *Close*.

### Changing Calendar Color

Each calendar has a name and a color associated with it. Although the name of the calendar cannot be edited in WebAccess, you can edit the color of the calendar.

1. Right-click the calendar you want to edit.
2. Select *Properties*.  

52 GroupWise 8 WebAccess Client User Guide
3 Select the color you want.
4 Click Save.
5 Click Close.

4.2.4 Using Shared Calendars

A shared calendar is like any other calendar, but other people have access to it and it also appears in their calendar lists. You can share existing personal calendars in your calendar list. You choose whom to share the calendar with, and what rights to grant each user. Then, users can post calendar entries to the shared calendar. You can’t share your main calendar.

- “Sharing an Existing Calendar with Other Users” on page 53
- “Posting a Calendar Entry to a Shared Calendar” on page 53

Sharing an Existing Calendar with Other Users

1 In the Folder List, right-click the calendar you want to share, then click Share.

2 Select Shared with.

3 In the Name field, start typing the name of a user.

   or

   Click the Address Book button to select the user in the Address Book window.

4 When the user’s name appears in the field, click Add User to move the user into the Shared list.

5 Click the user’s name in the Shared list.

6 Select the access options you want for the user.

7 Repeat Step 3 through Step 6 for each user you want to share the folder with.

8 Click Save, then click Close.

Posting a Calendar Entry to a Shared Calendar

1 Right-click the shared calendar, then click Display this calendar only.

2 In the shared calendar, select a date, then click a time in the Appointments List.

3 (Optional) Type a subject and a place if necessary.

4 Make sure the correct calendar is selected from the Calendar drop-down menu.

5 For more options, such as the Start Date, Time, Show As, Duration, or the appointment message, click More options.

6 Click Post on the toolbar.
4.3 Sending Calendar Items

- Section 4.3.1, “Understanding the Calendar Item Icons,” on page 54
- Section 4.3.2, “Scheduling Appointments,” on page 54
- Section 4.3.3, “Sending Reminder Notes,” on page 57

4.3.1 Understanding the Calendar Item Icons

The icons that appear in your calendar give you additional information about items. For more information, see Section 1.8, “Identifying the Icons Appearing Next to Items,” on page 18.

4.3.2 Scheduling Appointments

Use appointments to schedule blocks of time on a specific date or range of dates. You can use Busy Search to check for a time when all the users and resources you want for an appointment are available.

When you schedule an appointment and include yourself as a participant, GroupWise automatically accepts the appointment for you.

- “Scheduling an Appointment for Yourself” on page 54
- “Scheduling an Appointment for Multiple People” on page 55
- “Checking Availability” on page 56
- “Rescheduling an Appointment” on page 56
- “Canceling an Appointment” on page 57
- “Canceling a Recurring Appointment” on page 57

Scheduling an Appointment for Yourself

If you are not available for meetings, schedule a posted appointment for those times. When another user includes you in an appointment and does a busy search, the user can see that you are not available at those times, but can still schedule over your appointment.

Posted appointments are placed in your Calendar on the date you specify. They are not placed in your Mailbox or in any other user’s Mailbox. Similarly, all posted appointments are saved to your main GroupWise Calendar. To move them to a personal calendar, drag and drop them to the personal calendar after they are created.

1. On the toolbar, click the arrow next to New, then click Posted Appointment.
   
   or
   
   In your Calendar, select a date, then click a time in that day.
2 (Optional) Type a subject and a place.

3 Specify the start date.

4 Specify a start time and duration. Duration can be in minutes, hours, or days.

5 Specify how you want the appointment to appear with the Show As drop-down menu.
   Appointments can appear as Busy, Free, Out of the Office, or Tentative.

6 (Optional) Type a message.

7 Click Post on the toolbar.

Scheduling an Appointment for Multiple People

1 On the toolbar, click the arrow next to New, then click Appointment.

2 In the To field, type a username, then press Enter. Repeat for additional users. Include any resource IDs (such as conference rooms) in the To field. If necessary, type usernames in the CC and BC fields.

   or

   To select usernames or resources from a list, click Address Book on the toolbar, search for each user’s name, select each user, then click OK.

   Your name is automatically added to the To field of the appointment. When you send the appointment, it is automatically added to your calendar. If you do not want to be included in the message, delete your name from the To field.

3 Type the location description in the Location field.

4 Specify the start date.

5 Specify a start time and duration. Duration can be in minutes, hours, or days.

6 Specify how you want the appointment to appear as from the Show As drop-down menu.
   Appointments can appear as Busy, Free, Out of the Office, or Tentative.

7 Type a subject and message.

   If you want, change the font of the message text. For information, see “Changing the Font in the HTML View” on page 30.
If you want to make sure the people and resources for the appointment are available, you can do a busy search by clicking Busy Search on the toolbar. For more information, see “Checking Availability” on page 56.

You can specify many options, such as making this appointment a high priority, requesting a reply from recipients, and more, by clicking the Send Options tab.

Click Send on the toolbar.

Checking Availability

Use Busy Search to find a time when all the people and resources you want to schedule for a meeting are available.

1 In an appointment you are creating, specify usernames and resource IDs in the To field.
2 Specify the first possible day for the meeting in the Start Date field.
3 Specify the meeting’s duration.
4 Click Busy Search on the toolbar.
   The bottom of the Appointment window shows the available times.
5 Click one of the suggested times to select an available meeting time, then make sure the correct starting time is specified.
6 To remove a user or resource from the To list after the search, click the list, click the username or resource to remove, then click Delete.
   This is useful if you want to include several conference rooms in the search to find one that is available, then eliminate those you do not want.
7 Complete and send the appointment.

Rescheduling an Appointment

If you want to make changes to the people and resources for the appointment, you can reschedule an appointment.

1 Click the Sent Items folder in the Folder List.
2 Select the appointment you want to reschedule and open it.
3 In the Appointment window, click Resend on the toolbar.
4 Select Retract Original Item? to delete your original appointment.
5 Make your changes, then click Send on the toolbar.
Canceling an Appointment

You can cancel an appointment if you scheduled it or if you have the necessary Proxy rights to the scheduler's Mailbox.

1. In your calendar, right-click the appointment you want to cancel, then click Delete.
2. Select Delete From All Mailboxes to remove it from other users’ mailboxes. Leave this option deselected if you only want to delete it from your own mailbox.
3. (Optional) Type a message explaining the cancellation.
4. Click OK.

Canceling a Recurring Appointment

You can cancel a recurring appointment if you scheduled it or if you have the necessary Proxy rights to the scheduler's Mailbox. Recurring appointments cannot be scheduled from WebAccess; they can only be deleted.

1. In your calendar, right-click the recurring appointment you want to cancel, then click Delete.
2. Select Delete From All Mailboxes to remove the appointment from the mailboxes you sent it to. Leave this option deselected if you want to delete the message from only your own mailbox.
3. (Optional) Type a message explaining the cancellation.
4. Click OK.
5. Click This Instance or All Instances.

4.3.3 Sending Reminder Notes

Reminder notes are like mail messages, except they are scheduled for a particular day and appear on the Calendar for that date. You can use reminder notes to show vacations, holidays, paydays, birthdays, and so forth.

- “Scheduling a Reminder Note for Yourself” on page 57
- “Scheduling a Reminder Note for Other Users” on page 58

Scheduling a Reminder Note for Yourself

A reminder note to yourself is called a posted reminder note. Posted reminder notes are placed in your Calendar on the date you specify. They are not placed in your Mailbox or in any other user's Mailbox.

1. In the Day view of your Calendar, type the reminder note message in the Add a note field of the Notes section.

or

1. On the toolbar, click the arrow next to New, then click Posted Note.
2. Select a date.
3. Type a subject and the reminder note message.
4. Click Post on the toolbar.

To access the information later, open your Calendar and select the date the information appears on. Double-click the reminder note in the Reminder Notes List.
Scheduling a Reminder Note for Other Users

1. On the toolbar, click the arrow next to New, then click Note.

2. In the To field, type a username, then press Enter. Repeat for additional users. If necessary, type usernames in the CC and BC fields.
   
   or

   To select usernames from a list, click Address on the toolbar, select each user’s name, double-click each user, then click OK.

3. In the Start Date field, select the date this reminder note should appear in the recipients’ Calendars.
   
   You can specify many options, such as making this reminder note a high priority, requesting a reply from recipients, and more, by clicking the Send Options tab.

4. Type a subject and the reminder note message.

5. Click Send on the toolbar.

4.4 Receiving Calendar Items

- Section 4.4.1, “Accepting or Declining Calendar Items,” on page 58
- Section 4.4.2, “Delegating Calendar Items,” on page 59
- Section 4.4.3, “Saving Calendar Items,” on page 59
- Section 4.4.4, “Moving an Appointment to a Different Calendar,” on page 59

4.4.1 Accepting or Declining Calendar Items

When you receive an appointment, task, or reminder note, you might not be able to accept it. In GroupWise, you can let the sender know if you accept or decline, specify a level of acceptance or availability, and add additional comments. You can also delegate the item to another user. The sender can find your response by checking the item’s properties.

If you decline an appointment after its start time, the sender sees the appointment as deleted rather than declined in the appointment’s properties.

1. Open the appointment, task, or reminder note.

2. Click Accept or Decline on the toolbar.

3. (Optional) Type a message in the Comments to Sender field.
   
   By default, the sender can view your comment by viewing the item properties in the Sent Items folder. However, for a more noticeable indication when someone declines an item, the sender has the option under Options > Send Options to set Return Notification When Declined to Mail Receipt, Notify, or both.

4. (Optional) Select the calendar where you want the message displayed.

5. Click Accept (or Decline) to close the window

6. If the calendar item is set as a recurring event, you are prompted to accept/decline all events or just this event.
4.4.2 Delegating Calendar Items

Use Delegate to reassign a scheduled item to someone else. The sender can determine who you delegated the item to by looking at the item’s properties.

1. Double-click an appointment, task, or note to open it.
2. Click Delegate to open a Delegate form.
3. In the To field, type a username, then press Enter.
   or
   To select a username from a list, click Address Book on the toolbar, search for and select each user’s name, click To, then click OK.
4. Type any additional comments to the recipient.
5. Click Send on the toolbar.

4.4.3 Saving Calendar Items

Saved items remain in your Calendar as well as being copied to the location you specify. Items are saved in HTML format with a .html extension so that they can also be opened in your Web browser. Attachments are saved in their original format.

1. Open the item you want to save, then click File > Save Page As.
2. Type a name for the file in the Name field.
3. Select the location from the Save in folder drop-down menu.
   or
   Select Browse for other folders for a different location.
4. Click Save.

4.4.4 Moving an Appointment to a Different Calendar

Items on the calendar can be moved to other calendars.

1. Select the calendar item to move.
2. Click and drag the item to the new calendar.
   The icon with the item changes from red to green when it is in a valid location.

4.5 Publishing Personal Calendars on the Internet

You can select to publish personal calendars or your free/busy schedule to the Internet. When you publish a personal calendar to the Internet, that calendar can then be viewed by anyone on the Internet. When you publish your personal calendar, it is published to your system’s Calendar Publishing Host. For additional information about your Calendar Publishing Host, see your system administrator.

The ability to publish your personal calendar can be enabled and disabled by your system administrator. If your system administrator has disabled the ability to publish personal calendars, this option is not displayed in the GroupWise client.

- Section 4.5.1, “Publishing a Personal Calendar,” on page 60
- Section 4.5.2, “Modifying a Published Calendar’s Settings,” on page 60
4.5.1 Publishing a Personal Calendar

You cannot publish the main GroupWise Calendar; you can only publish a personal or shared calendar.

NOTE: Published calendars display as part of a Web address for identification. Special characters like ‘!’, ‘@’, ‘#’, ‘|’, should not be used as part of the calendar name, because it might cause the calendar to display incorrectly in the Calendar Publishing Host.

1. In the Calendar Folder List, right-click the calendar you want to publish, then click Publish.
2. Select Publish.
3. Select the time period.
   Select Entire calendar to send your entire calendar.
   or
   Select Previous to send part of your calendar. If you select Previous, you must specify a range of days to send.
4. Select Private Items to include private items.
5. Select Include Attachments to include attachments.
6. To send someone a link to your published calendar, click Send Publish Link.
   If you click Send Publish Link, a new e-mail message is opened with a link. Select who you want to send the message to, then click Send.
7. Click Save, then click Close.

4.5.2 Modifying a Published Calendar’s Settings

1. In the Folder List, right-click the published calendar, then click Publish.
2. Modify any publish options. For more information, see Step 3 through Step 6 of Section 4.5.1, “Publishing a Personal Calendar,” on page 60.
3. Click Save, then click Close.

4.5.3 Unpublishing a Calendar

When you unpublish a calendar, the published calendar no longer displays in the list of published calendars on the Calendar Publishing Host. If anyone has subscribed to your calendar, they no longer receive updates to your calendar and they might receive an error message.

1. In the Folder List, right-click the published calendar, then click Publish.
2. Deselect Publish, click Save, then click Close.
4.5.4 Publishing Your Free/Busy Schedule

Free/busy information in GroupWise can be published to allow access for other users. The free/busy information can be accessed by other GroupWise users or any other users who can accept a .ifb file type.

1. On the main WebAccess page, click Options in the upper right corner.
2. Click the Calendar tab.
3. Select Publish my free/busy information.
4. Click Send Free/Busy Publish Location.
   If you click Send Free/Busy Publish Location, a new e-mail message is opened with a link. Select who you want to send the message to, then click Send.
5. Click Save, then click Close.

4.6 Printing a Calendar

Printing from WebAccess depends on the printing capabilities of your Web browser.

In the Month view, you can print different calendar items by selecting the item types in the upper right corner.

1. Click Print View in the top right corner of a Calendar View to open a printer-friendly version of the calendar.

   **IMPORTANT:** Do not use File > Print in your Web browser. The graphical calendar displayed in WebAccess cannot be printed as it displays on the screen.

2. Click Print this page to display a printable list of your appointments, notes, and tasks.
3. Select print options and print the calendar as you normally would in your Web browser.
Tasks and the Tasklist

5.1 Understanding Tasks

A task is an item that has a due date and requires a specific action. You can post a task for yourself or accept a task from another person.

After it is accepted, a task appears on the Calendar on its start date and carries over to each succeeding day. When the due date is past, the task displays in the Overdue section on the Calendar.

After you finish a task, you can mark it as complete. When you mark a task as complete, it no longer carries over to the next day on your Calendar.

As the originator of an assigned task, you can have GroupWise send you notification when the task is marked as complete. A Completed status, including the date and time the task was marked as complete, is placed in the Properties window for the task.

5.2 Understanding the Tasklist Folder

The Tasklist folder is a system folder that is used to keep track of GroupWise tasks and other items that require action. Think of it as a master list of all your tasks.

When you post or accept a task, it automatically appears in the Tasklist folder. In addition, any item type (mail, appointment, task, reminder note, phone message) can be placed in the Tasklist folder. For example, you can place an e-mail in the Tasklist folder to remind yourself that you need to act on it.

NOTE: The Tasklist replaces the Checklist folder in previous versions of GroupWise. Checklist items appear in the Tasklist folder, but are not converted to tasks.
Items in the Tasklist folder do not always appear on the Calendar. Only items with a due date appear on the Calendar. If you want an item in the Tasklist folder to appear on your Calendar, you must assign that item a due date, as explained in Section 5.4.2, “Assigning a Due Date to a Tasklist Item,” on page 67.

*Figure 5-1  Mailbox Showing the Tasklist Folder*

After you have placed an item in the Tasklist folder, you can:

- Change its position in the Tasklist (“Reordering the Tasklist Folder” on page 67)
- Assign it a due date (Section 5.4.2, “Assigning a Due Date to a Tasklist Item,” on page 67)
- Mark it as complete (Section 5.3.2, “Tracking Task Completion,” on page 66)

5.3 Using Tasks

A task is an item to be completed by a specified date and time. When you assign a task to a user, the user can accept or decline the task, but until it is declined or completed, the task appears in the user’s Tasklist folder and on the user’s Calendar each day.

- Section 5.3.1, “Assigning a Task,” on page 64
- Section 5.3.2, “Tracking Task Completion,” on page 66

5.3.1 Assigning a Task

When you create a task, you can assign it to yourself (a posted task) or assign it to multiple people.

- “Assigning a Task to Other Users” on page 64
- “Assigning a Task to Yourself” on page 65

Assigning a Task to Other Users

1 On the main WebAccess page, click the arrow next to New, then click Task.
2 In the To field, type a username, then press Enter. Repeat for additional users. If necessary, type usernames in the CC and BC fields.
   or
   To select usernames from a list, click Address Book on the toolbar, search for and select each user, then click OK.
3 Type the date you want the task to begin and the date you want the task to be completed. You can type the same date in both fields.

or

Click to specify dates for your task.

4 Type the subject.

5 (Optional) Type a priority for the task.
   The task priority can consist of a character followed by a number, such as A1, C2, B, or 3.

6 Type a description of the task.

7 (Optional) Click the Send Options tab to specify other options, such as making this task a high priority, requesting a reply from recipients, and more.

8 Click Send on the toolbar.

Assigning a Task to Yourself

1 In your Calendar, open the Day view, then select a date.
   If you try to post a task to a date earlier than today, the task is posted to today’s date.

2 In the Tasks section, click the Add a task field.

3 Type a subject.

4 Press Enter.
   Your task is immediately posted to the date you selected. GroupWise uses the date you selected as the starting and ending date for your task.

5 (Optional) To change the starting date, ending date, description or to add a priority to your task, double-click the task in the Tasks section.

6 Click Post on the toolbar.

Posted tasks are placed in your Calendar and in your Tasklist folder. They are not placed in your Mailbox, or in any other user’s Mailbox.

TIP: You can also create a Tasklist that is not associated with your Calendar. In this type of list, any item type (mail, appointment, task, reminder note, phone message) can be used. For information, see “Using the Tasklist Folder” on page 66.
5.3.2 Tracking Task Completion

When you finish a task, you can mark it as complete. Tasks you mark as complete are not carried over to the next day on your Calendar. Completed tasks are distinguished by a check mark in your Calendar. Overdue tasks display in the Overdue section of your Tasklist.

If you mark a task as complete, then realize you left some part of it incomplete, you can unmark it. Unmarked tasks display on the current day in your Calendar.

- “Marking an Item As Complete” on page 66
- “Checking the Completion Status of a Task You Sent” on page 66

Marking an Item As Complete

1. Click Calendar on the Nav Bar.
   Tasks can also be marked as complete in the Tasklist folder. See Section 5.3.2, “Tracking Task Completion,” on page 66 for more information.
2. In your Tasks section, select the check box next to the task.
   To unmark a task that has been marked as complete, deselect the marked check box next to the task.

Checking the Completion Status of a Task You Sent

1. Click the Sent Items folder in the Nav Bar.
   If you also assigned the task to yourself, you can find it in the Calendar or in the Tasklist folder.
2. Right-click the task you want to check, then click Properties.

5.4 Using the Tasklist Folder

The Tasklist folder is a system folder used to keep track of GroupWise tasks and other items that require action. Any item type (mail, appointment, task, reminder note, phone message) can be placed in the Tasklist folder.

- Section 5.4.1, “Moving an Item from Another Folder to the Tasklist Folder,” on page 66
- Section 5.4.2, “Assigning a Due Date to a Tasklist Item,” on page 67
- Section 5.4.3, “Reordering the Tasklist Folder,” on page 67

5.4.1 Moving an Item from Another Folder to the Tasklist Folder

A common way to place items in the Tasklist folder is to move those items from other folders. For example, you might receive an appointment for a meeting where you are expected to give a brief presentation. You can add that appointment to your Tasklist folder so it reminds you that you have a presentation coming up.

1. Open the folder containing the item you want to make into a task, then open that item.
2. Click , then click Move to Folder.
3. Click the Tasklist folder.
You can move the task to the top or bottom of the list by using the arrows in the right corner of your Tasklist page.

4 Open the newly moved item and click 🔄.
5 Select *Activate Tasklist due date* and select a due date.
6 Click *Save*.

In the Calendar, the items display with a check box to the left of them. When you complete an item in the Tasklist, you can mark it complete by selecting the check box.

### 5.4.2 Assigning a Due Date to a Tasklist Item

1. Open an item in the Tasklist folder.
2. Click 🔄.
3. Select *Activate Tasklist due date*, then select a date.

### 5.4.3 Reordering the Tasklist Folder

There are multiple ways to change the order of items in the Tasklist folder:

- “Moving Items Up or Down in the Tasklist” on page 67
- “Moving an Item to the Top or Bottom of the Tasklist” on page 67

#### Moving Items Up or Down in the Tasklist

1. Open the Tasklist folder.
2. Select the item you want to move.
3. (Conditional) To move the item up in the list, click the up-arrow located above the Folder List until the item is in the desired position.
4. (Conditional) To move the item down in the list, click the down-arrow located above the Folder List until the item is in the desired position.

#### Moving an Item to the Top or Bottom of the Tasklist

1. Open the Tasklist folder.
2. Select the item you want to move.
3. (Conditional) To move the item to the top of the list, click the *Move to top* arrow located above the Folder List.
4. (Conditional) To move the item to the bottom of the list, click the *Move to bottom* arrow located above the Folder List.
6 Contacts and Address Books

Use an address book like a contact management tool, phone directory, and information center for your addressing needs. Address books can store names and addresses, e-mail addresses, phone numbers, and much more. Contacts folders display address book information in convenient address card format. Entries in an address book can be a contact, group, resource, or organization.

- Section 6.1, “Understanding Address Books,” on page 69
- Section 6.2, “Using the Address Books to Address Items,” on page 70
- Section 6.3, “Using the Contacts Folder,” on page 72
- Section 6.4, “Working with Address Books,” on page 79

6.1 Understanding Address Books

In the Windows, Linux, and Macintosh versions of the GroupWise client, users can share address books with other users. In GroupWise WebAccess, you cannot share an address book with other users, but you can receive shared address books. When you accept a shared address book, it appears in your Address Book list along with your system address book, personal address book, and Frequent Contacts address book.

GroupWise uses the following types of address books:

- Section 6.1.1, “GroupWise Address Book,” on page 69
- Section 6.1.2, “Frequent Contacts Address Book,” on page 70
- Section 6.1.3, “Personal Address Books,” on page 70

6.1.1 GroupWise Address Book

The GroupWise Address Book is the address book configured and maintained by the system administrator. Use this address book to view information about everyone in your GroupWise system.

The GroupWise Address Book is marked with a icon.

Because the GroupWise Address Book is generally quite large, you might want to search for names or use predefined Finds to find the name you are looking for, rather than scrolling through the entire address book. For more information, see “Searching for Users, Resources, Organizations, and Groups” on page 82 and “Using Filters to Narrow an Address Search” on page 82.

You can view information about contacts in the GroupWise Address Book, but you cannot edit this information.
6.1.2 Frequent Contacts Address Book

Use the Frequent Contacts address book to access your most frequently used or most recently used entries. When you use an address in a message, the entry is copied to the Frequent Contacts address book if the book's options are set to do so. Addresses added by the GroupWise Windows client also appear in the GroupWise WebAccess Frequent Contacts address book.

The Frequent Contacts address book is marked with a icon.

Although the Frequent Contacts address book is created by GroupWise, it is considered a personal address book because you can edit the information for contacts.

After an entry is placed in Frequent Contacts, it remains there until you delete it. The entry also remains in its original address book.

6.1.3 Personal Address Books

You can create, edit, save, and rename multiple address books for your personal use. For information on creating a personal address book, see Section 6.4.2, “Creating a Personal Address Book,” on page 79.

Personal address books are marked with a icon.

You can add and delete names and address information for any contact (person, organization, or resource) you want in your personal address books.

When you create multiple address books, you can include the same name and address in several books.

Personal address books list addresses according to your preferences. For example, you can include Internet addresses or no address at all for the people you add to your personal address books. You can also create personal groups. If you save a list of people as a group, you only need to type the group name in the To box to send the entire group a message. See “Organizing Addresses in Groups” on page 75.

6.2 Using the Address Books to Address Items

There are multiple ways to address an item in GroupWise:

- Section 6.2.1, “Using the Address Selector,” on page 70
- Section 6.2.2, “Sending Mail from the Address Book,” on page 72

6.2.1 Using the Address Selector

When you are composing a new item and click Address Book on the item view toolbar, the Address Selector displays. The Address Selector presents a simplified view of the Address Book, providing you with the options you need to select a name or create a group.

- “Understanding the Address Selector” on page 71
- “Addressing an Item with the Address Selector” on page 71
**Understanding the Address Selector**

The Address Selector displays in places throughout GroupWise, such as when you are selecting members of a group or entries for a filter or find. It might be slightly modified to show only context-appropriate options.

In the Address Selector, you view one address book at a time. To choose a different address book to look at, click an address book in the *Address Books* drop-down list.

Select the entries you want placed in *To*, *CC*, or *BC* fields of the item you are addressing. You can filter the list of entries by groups, people, organization, and resources by using the *Entry Type* drop-down list. You can also search the list by name, first name, last name, or a variety of other options by using the drop-down lists.

You can resize the Address Selector by dragging a corner of the window. You can open a contact entry to view details by clicking the contact’s name.

You can add contacts to the right pane and then create a group by clicking *Save Group*. If you click the *Save Group* button, you can select which address book the group is saved to. Otherwise it is saved to the address book displayed in the Address Selector. You cannot save a group to the main GroupWise address book unless you are an administrator with the proper rights.

To create a new contact, click *New*. Enter the contact information in the different tabbed pages, then click *OK*. For more information, see Section 6.4.6, “Viewing Contacts, Groups, Organizations, or Resources in an Address Book,” on page 81.

**Addressing an Item with the Address Selector**

Use the Address Selector to address items you are composing. For more information about the Address Selector, see Section 6.2.1, “Using the Address Selector,” on page 70.

1. In an item you are composing, click *Address Book* on the toolbar.
2. Select an address book from the *Address Books* drop-down list.
3. Search for the names you want as primary (To) recipients of your message.
4. Select each name you want to include.
5. Click *To*.
6. To address carbon copy recipients, select the names you want, then click *CC*.
7. To address blind copy recipients, select the names you want, then click *BC*.
8. Click *Entry Type* to show only contacts, groups, resources, or organizations.
9. Click the *begins with* drop-down list to select how you want to locate a recipient (by first name, last name, or department), then select the recipient’s name.
10. Click *OK*.

If you know the person’s name, begin typing it in the *To* field of the item view. Name Completion searches the Frequent Contacts address book, the current address book, and the GroupWise Address Book, if they are listed in the Name Completion Search Order. When Name Completion finds the person you want to send a message to, you can stop typing.
6.2.2 Sending Mail from the Address Book

Use Mail to send items from an address book. If you have opened the address book from the main GroupWise WebAccess page, the address book is not connected to an item view. Mail lets you open an item view from the address book.

1. On the main WebAccess page, click Address Book on the toolbar.
2. Select an address book from the drop-down list.
3. Search for and select the users you want.
4. Click To.
5. Click Mail.

6.3 Using the Contacts Folder

Use the Contacts folder to view, update, delete, and add information to the contacts in your address book.

The Contacts folder in the GroupWise Folder List, by default, represents the Frequent Contacts address book.

Any modification you make in the Contacts folder is also made in the corresponding address book (Frequent Contacts or other address book).

The Folder List displays a list of all personal address books under the Contacts folder. You can quickly select a different personal address book by clicking the address book in the Folder List.

Clicking QuickViewer on the toolbar allows you to quickly view and edit details for a contact, group, resource, or organization.

For more information, see Section 6.3.1, “Managing Contacts,” on page 72, Section 6.3.2, “Managing Groups,” on page 74, Section 6.3.3, “Managing Resources,” on page 76, and Section 6.3.4, “Managing Organizations,” on page 77.

- Section 6.3.1, “Managing Contacts,” on page 72
- Section 6.3.2, “Managing Groups,” on page 74
- Section 6.3.3, “Managing Resources,” on page 76
- Section 6.3.4, “Managing Organizations,” on page 77
- Section 6.3.5, “Using Frequent Contacts to Address an Item,” on page 78

6.3.1 Managing Contacts

Each contact in the Contacts folder is marked with . When you double-click a contact, the contact item view displays.

- “Adding a Contact” on page 73
- “Modifying a Contact” on page 73
- “Deleting a Contact” on page 73
- “Changing the Display Name of a Contact” on page 74
- “Viewing All Correspondence with a Contact” on page 74
- “Journaling Interactions with Contacts” on page 74
Adding a Contact

You can add a contact to either the Frequent Contacts address book or a personal address book.

1. On the main WebAccess page, click Contacts on the Nav Bar.
2. Select the address book you want to add the contact to.
3. Click New on the toolbar, then select Contact.
4. In the name fields, specify the contact’s First, Middle, and Last names.
5. In the Display Name field, specify the name you want to use for the contact.
6. Specify any other information you want to record about the contact.
   - Summary: Displays a summary of the information contained in the other pages.
   - Contact: Use this page to specify the contact’s name, multiple e-mail address, multiple phone numbers, and multiple instant messaging IDs.
   - Details: Use this page to specify the contact’s profession, department, assistant, birthday, anniversary, spouse, children, hobbies, and any Internet addresses associated with the contact.
   - Address: Use this page to specify the contact’s office, home, and any other addresses.
   - Notes: Use this page to view information about your interaction with this contact that you entered in the GroupWise Windows client. This page can function like a contact journal.
   - History: Displays all the items you have sent to or received from this contact.
7. Click Save & Close.

Modifying a Contact

You can modify a contact’s information in either the Frequent Contacts address book or a personal address book. In order to modify a contact from your corporate address book, you must first copy the contact to either your Frequent Contacts address book or a personal address book.

1. Click the Contacts tab on the Nav Bar.
2. Select the address book you want to modify the contact in.
3. In the contact list, double-click the contact you want to modify.
4. Make any needed modifications to the contact.
   - For information about the contact details you can enter on each tab, see “Adding a Contact” on page 73.
5. Click Save & Close.

Deleting a Contact

You can delete a contact in either the Frequent Contacts address book or a personal address book. You cannot delete a contact from your corporate address book.

1. Click the Contacts tab on the Nav Bar.
2. Select the address book you want to delete the contact in.
3. In the contact list, click the contact, then click Delete.
Changing the Display Name of a Contact

The display name is the name that displays when you begin typing in the To (or BC or CC) field of a message. When you begin typing a name, for example “Ta,” Name Completion fills in the rest of the name with a name from the address book, for example “Tabitha Hu.” However, if there are two Tabitha Hus in the address book, one in Accounting and one in Facilities, it might be difficult for you to know which name Name Completion has filled in, unless you take the time to look at more properties.

You can change the display name so that it’s easy to know which name Name Completion has filled in. For example, if you only correspond with Tabitha Hu in Accounting, you could change the display name to Tabitha--Accounting.

1. Click the Contacts tab on the Nav Bar.
2. Click the address book you want to modify the contact in.
3. Double-click a contact.
4. Type a new name in the Display field.
5. Click OK.

Viewing All Correspondence with a Contact

1. Click the Contacts tab on the Nav Bar.
2. Click the address book you want to use.
3. Double-click a contact.
   - All items you have received from or sent to this contact display in the History tab.
4. Click the History tab.

Journaling Interactions with Contacts

Like a journal, the notes feature has the ability to log your various interactions with your contacts.

1. Click the Contacts tab on the Nav Bar.
2. Click the address book you want to use.
3. Double-click a contact.
4. Click the Notes tab.

6.3.2 Managing Groups

Each group in the Contacts folder is marked with . When you double-click a group, the group item view displays.

- “Organizing Addresses in Groups” on page 75
- “Creating and Saving a Personal Group” on page 75
- “Adding Contacts to a Group” on page 75
- “Deleting a Contact from a Group” on page 75
- “Addressing Items to a Group” on page 76
- “Viewing Group Information” on page 76
Organizing Addresses in Groups

A group is a list of users or resources you can send messages to. Use groups to send a message to several users or resources by typing the group name in the To, BC, or CC fields. There are two types of groups: public and personal.

A public group is a list of users created by the system administrator, and it is available for use by each GroupWise user. For example, there might be a public group for the Accounting Department. Each employee in Accounting is included in the group. Public groups are listed in the system address book.

A personal group is a group created by you. For example, if you often send an appointment to your work group, you can include each co-worker’s address or name and a meeting place (a resource) in a personal group.

Creating and Saving a Personal Group

1. On the main WebAccess page, click Address Book on the toolbar.
2. Click the personal address book you want to add the group to.
3. Search for and select each user, click To, CC, or BC for each user, then click Save Group.
4. Type a name for the group.
5. (Optional) Type any comments, such as a description for the group.
6. Click Save to save the group in the personal address book.

Adding Contacts to a Group

If you are adding contacts to a group, such as a corporate distribution list, you must have the proper rights granted to you by the system administrator.

1. On the main WebAccess page, click Address Book on the toolbar.
   or
   In an item you are composing, click Address Book on the toolbar.
2. Select the address book where the group is located, then search for the group.
3. Click the group name, then click Modify.
   Groups are marked with ✉.
4. To add a contact, select the address book the contact is in, search for and select the contact, then click To, CC, or BC.
5. Click Save Group.

Deleting a Contact from a Group

1. On the main WebAccess page, click Address Book on the toolbar.
2. Select the address book where the group is located, then search for the group.
3. Click the group name, then click Modify.
4. Click the red X next to the contact’s name in the group list.
5. Click Save Group.
Addressing Items to a Group

1 In an item view, click Address Book on the toolbar.
2 Select the address book where the group is located, then search for the group.
3 Select a group, then click To, CC, or BC.
4 (Optional) To show all the members of the group, click the group name.
5 Click OK to return to the item view.

Viewing Group Information

1 On the main WebAccess page, click Address Book on the toolbar, select the address book where the group is located, then search for the group.
   or
   Click Address Book on the toolbar in an item you are composing.
   or
   Click the Contacts tab in the Nav Bar.
2 Click the group name.

6.3.3 Managing Resources

Resources are items that can be scheduled for meetings or other uses. Resources can include rooms, computer projectors, cars, and more. The system administrator defines a resource by giving it an identifying name and assigning it to a user. Resources can be included in a busy search, just as users can. Resource IDs are entered in the To box. A user assigned to manage a resource is the owner of that resource.

The owner of a resource is responsible for accepting and declining appointments for the resource. In order to do so, the owner must have full proxy rights to the resource. As a resource owner, you can select to receive notification of appointments for the resource.

- “Accepting and Declining Resource Requests” on page 76
- “Adding a Personal Resource” on page 77
- “Modifying a Personal Resource” on page 77
- “Deleting a Personal Resource” on page 77

Each resource in the Contacts folder is marked with 📋. When you click a resource, the resource item view displays.

Accepting and Declining Resource Requests

You can accept or decline requests for a resource only if you are the owner and have been granted Read and Write rights.

1 On the main WebAccess page, click Proxy in the toolbar.
2 Click the resource you own.
   If the resource you own isn’t listed, type the name of the resource you own, then click Login.
3 Click the item you need to accept or decline.
4 Click Accept or Decline on the toolbar.
Adding a Personal Resource

You can add a personal resource to either the Frequent Contacts address book or a personal address book.

1. On the main WebAccess page, click Address Book on the toolbar.
2. Select the personal address book you want to add the resource to.
3. Select Resource from the New drop-down list.
4. In the Name field, specify the name for the resource.
5. Specify any other information you want to record for the resource.
6. In the Comments field, specify any comments you might have for the resource. For example, you might want to specify how big a conference room is or what type of equipment is in the room.
7. Click Save & Close.

Modifying a Personal Resource

1. On the main WebAccess page, click Contacts on the toolbar, then select the resource.
2. Search for the resource you want to modify. Resources are marked with .
3. Double-click the resource.
4. Modify any information as needed.
5. Click Save.

Deleting a Personal Resource

1. On the main WebAccess page, click Contacts on the toolbar.
2. Select the address book where the resource is located, then search for the resource.
3. Select the group, then click Delete.

6.3.4 Managing Organizations

Each organization in the Contacts folder is marked with the Organization icon. When you click an organization, the organization item view displays.

- “Adding a Personal Organization” on page 77
- “Modifying a Personal Organization” on page 78
- “Deleting a Personal Organization” on page 78

Adding a Personal Organization

You can add an organization to your Frequent Contacts address book or a personal address book.

1. On the main WebAccess page, click Contacts on the toolbar.
2. Click the personal address book you want to add the organization to.
In the Organization field, specify the name of the organization.
5 Specify any other information you want to record for the organization.
6 Click Save & Close.

### Modifying a Personal Organization

1 On the main WebAccess page, click Contacts on the toolbar, then select the address book where the organization is located.
   
   or
   
   Click Address Book on the toolbar in an item you are composing.
2 Search for the organization.
   
   Organizations are marked by the icon.
3 Double-click the organization
4 Modify any information as needed.
5 Click Save & Close.

### Deleting a Personal Organization

1 On the main WebAccess page, click Contacts on the toolbar, then select the address book where the organization is located.
   
   or
   
   Click Address Book on the toolbar in an item you are composing.
2 Select the organization, then click Delete.
   
   Organizations are marked by the icon.

### 6.3.5 Using Frequent Contacts to Address an Item

Use the Frequent Contacts address book to access your most frequently used or most recently used entries. When you use an address in a message, the entry is copied to the Frequent Contacts address book.

After an entry is placed in Frequent Contacts, it remains there until you delete it. The entry also remains in its original address book.

1 Click Address Book in an item you are composing.
2 Select Frequent Contacts from the Address Book drop-down list.
3 Search for and select the users you want.
4 Click To, CC, or BC for the selected users.
5 Click OK.

The Frequent Contacts address book can be closed, but it cannot be deleted.
6.4 Working with Address Books

- Section 6.4.1, “Opening an Address Book,” on page 79
- Section 6.4.2, “Creating a Personal Address Book,” on page 79
- Section 6.4.3, “Editing a Personal or Frequent Contacts Address Book,” on page 80
- Section 6.4.4, “Deleting a Personal Address Book,” on page 80
- Section 6.4.5, “Accepting a Shared Address Book,” on page 81
- Section 6.4.6, “Viewing Contacts, Groups, Organizations, or Resources in an Address Book,” on page 81
- Section 6.4.7, “Searching for Address Book Entries,” on page 82

6.4.1 Opening an Address Book

To open an address book, click Address Book on the main WebAccess toolbar to display a drop-down menu that lists the GroupWise Address Book, Frequent Contacts address book, and any personal address books you have created.

You can use the drop-down menu to select the address books in this view. The left pane lists the matching search entries in the selected address book.

Using the Address Book, you can open contacts to view details, select names to send an item to, create and modify groups, and create and delete contacts.

The Address Book also provides you with advanced options, such as creating and modifying personal address books and changing your Name Completion search order.

6.4.2 Creating a Personal Address Book

1. On the main WebAccess page, click Address Book on the toolbar.
2. Click Address Book Options.
3. Click Create to display the Create Address Book form.
4. Type a name for the new book and a description (optional), then click OK.
5. Click Close to return to the Address Book.
6.4.3 Editing a Personal or Frequent Contacts Address Book

In a personal address book, including the Frequent Contacts address book, you can add or delete entries, edit existing information, copy names from one book to another, or rename a book.

- “Copying a Personal Address Book” on page 80
- “Copying Entries to Another Personal Address Book” on page 80
- “Renaming a Personal Address Book” on page 80
- “Deleting Entries from a Personal Address Book” on page 80

Copying a Personal Address Book

1. On the main WebAccess page, click Address Book on the toolbar.
2. Click Address Book Options.
3. Click Save As next to the personal address book you want to copy.
4. Type a name for the address book, then click OK.

Copying Entries to Another Personal Address Book

You cannot copy names to the GroupWise address book.

1. On the main WebAccess page, click Contacts on the toolbar.
2. Click an address book, then search for the entries you want to copy.
3. Select each entry you want to copy.
4. Click Copy.
5. Select the personal address book you want to copy the names to, then click OK.

Renaming a Personal Address Book

1. On the main WebAccess page, click Address Book on the toolbar.
2. Click Address Book Options.
3. Click the personal address book you want to rename.
   You cannot rename the Frequent Contacts address book.
4. Type the new name, then click OK.

Deleting Entries from a Personal Address Book

1. On the main WebAccess page, click Contacts on the toolbar.
2. Click an address book, then search for the names you want to delete.
3. Select each name you want to delete.
4. Click Delete.

6.4.4 Deleting a Personal Address Book

1. On the main WebAccess page, click Address Book on the toolbar.
2. Click Address Book Options.
3 Click Delete next to the name of the address book that you want to delete.
4 Click Close.

After it is deleted, a personal address book cannot be recovered.

6.4.5 Accepting a Shared Address Book

In the Windows, Linux, and Macintosh versions of the GroupWise client, users can share address books with other users. In GroupWise WebAccess, you cannot share an address book with other users, but you can receive shared address books. When you accept a shared address book, it appears in your Address Book list along with the GroupWise Address Book, Frequent Contacts address book, and personal address books.

1 Click the Mailbox icon in the Folder List.
2 Click the shared address book notification to open it, or right-click it > click Open.
3 Click Accept Address Book to add the address book to the Address Book list.

You can now use the shared address book to address items or look up user information, just as you would in other address books.

6.4.6 Viewing Contacts, Groups, Organizations, or Resources in an Address Book

Use the predefined filters on the View menu to display only groups, people, organizations, or resources in an address book.

By default, address books display all entries. Although all groups, organizations, and resources are marked by icons, finding specific entries in large address books can be difficult. A predefined filter displays only the type of entry you are looking for.

To view groups, organizations, or resources in an address book:

1 On the main WebAccess page, click Address Book on the toolbar.
2 Click an address book.
3 Click Entry Type to filter the list by contacts, groups, resources, or organizations.
4 Select Number of names to display.
5 Click Search.

The Address Book uses the following icons to identify contacts, resources, groups, and organizations:

- Contacts
- Resources
- Groups
- Organizations
6.4.7 Searching for Address Book Entries

You can specify search criteria by using the predefined filters. For example, you can use the \textit{begins with} filter to display only entries with last names that begin with “D.”

- “Searching for Users, Resources, Organizations, and Groups” on page 82
- “Using Filters to Narrow an Address Search” on page 82
- “Defining the Name Completion Search Order” on page 82

Searching for Users, Resources, Organizations, and Groups

1. On the main WebAccess page, click \textit{Address Book} on the toolbar.
   or
   Click \textit{Address Book} on the toolbar in an item you are composing.
2. Select the address book you want to search.
3. In the search field, begin typing what you are searching for.
   Name Completion completes the name.

Using Filters to Narrow an Address Search

1. On the main WebAccess page, click \textit{Address Book} on the toolbar.
   or
   Click \textit{Address Book} on the toolbar in an item you are composing.
2. Select the address book you want to search.
3. Select whether you want to search for the name, last name, first name, or other option.
4. Select which predefined filter you want to use: begins with, equals, does not begin with, or not equal.
   For example, to list only users whose last name is Davis, select \textit{Last Name}, select \textit{equals}, then type “Davis.”
5. Type the information you want to search for.
   Name Completion completes the name.
   Click \textit{Entry Type} to filter the list by contacts, groups, resources, or organizations.
6. Click \textit{Search}.

Defining the Name Completion Search Order

1. On the main WebAccess page, click \textit{Options} in the upper right corner.
2. Click the \textit{General} tab.
3. In the \textit{Available books} box, click or Ctrl+click the books you want Name Completion to search, then click \textit{Add}.
4. To change the search order of an address book, select the address book in the \textit{Selected Books} list, then click \textit{Move Down} or \textit{Move Up}.
5. To disable Name Completion, deselect the \textit{Enable Name Completion} check box.
6. Click \textit{Save}, then click \textit{Close}.
GroupWise WebAccess includes two features to help you search your e-mail, appointments, and other GroupWise items.

- **The Search tool:** The Search tool ( on the toolbar) enables you to specify a number of criteria to help you locate the item you need.
- **The Find tool:** The Find tool enables you to quickly search for an item within a folder.
- Section 7.1, “Understanding GroupWise Searches,” on page 83
- Section 7.2, “Searching for a Word or Phrase Using Find,” on page 84
- Section 7.3, “Searching with Criteria,” on page 84
- Section 7.4, “Narrowing a Search,” on page 84
- Section 7.5, “Viewing the Results of a Search,” on page 85
- Section 7.6, “Finding Text in Items,” on page 85

### 7.1 Understanding GroupWise Searches

Like other search engines, the GroupWise search engine creates an index of whole words that are contained in the items being searched. When you search with the Search tool, GroupWise compares your search criteria and attempts to match them with the words in the search index. Because the Search tool searches for whole words, Search does not locate partial words or punctuation.

The Find tool, on the other hand, recognizes consecutive characters, even if they are not whole words, as long as the characters exist in exactly the same order you enter them in the Find search box.

For example, if you are looking for an e-mail with “Project status meeting next Tuesday” as the subject, you can search for any or all of the words in the subject in either the search tool or the Find tool.

The following are among the successful search criteria to find that e-mail in each search tool:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Example</th>
<th>Finds</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search (by subject)</td>
<td>meeting tuesday</td>
<td>All items with either “meeting” or “tuesday” in the subject.</td>
</tr>
<tr>
<td>Find</td>
<td>meeting tuesday</td>
<td>All items with the phrase “meeting tuesday” together in exactly that order in the subject.</td>
</tr>
<tr>
<td>Find</td>
<td>meeting *day</td>
<td>All items with “meeting” followed immediately by a day of the week in the subject.</td>
</tr>
</tbody>
</table>
More information to help you make your searches successful can be found throughout this section. For details about options, operators, and wildcards that can be used to compose a search query, see Section 7.3, “Searching with Criteria,” on page 84.

7.2 Searching for a Word or Phrase Using Find

Find lets you display items that contain specific subjects, recipients, or words. Find will search all files and folders looking for exact matches.

When you use Find, all items that do not match the criteria you select are hidden from view. Find does not actually move or delete items; it displays certain items based on the criteria you specify. When you clear the Find criteria, the hidden items are displayed.

1. Open the folder you want to search.
2. Type a word or phrase in the Find field.
   The word or phrase can be any set of consecutive characters contained in the item you are trying to find.
3. Choose the item you want from the filtered list of items.

To clear the find criteria, click the name of the folder in the folder list.

7.3 Searching with Criteria

1. On the main WebAccess page, click Search on the toolbar.
2. To search for specific text, select Full Text or Subject, then type what you are looking for in the field.
3. To search for a name, select From or To/CC, then type the name in the field.
4. Select each item type you are looking for, then select each item source you are looking for.
5. To search for items based on the date they were created or delivered, in the Date range section, select Created or delivered between, then select the appropriate dates.
6. To search for items that are marked with a certain category, select the category in the Item Categories section.
7. In the Search in list box, click the folders and/or libraries you want to search in.
   You might need to click the plus sign (+) next to your user folder to expand the folder structure.
   All of your folders are searched by default. To speed up your search, select only the folders you want to search.
8. Click Find.
9. Choose the item you want from the filtered list of items.

7.4 Narrowing a Search

You can use Search to narrow your search.

- In the first field of the Search window, type the uncommon words you notice in the item. If you search using common words, the results of your search are likely too large to be very helpful.
To increase the speed of your search, select the folders that probably contain the item you are looking for.

If you cannot find the document or message, check your search criteria for misspelled words. Also, check the syntax of your search to make sure you are telling Search to search for exactly what you want.

7.5 Viewing the Results of a Search

Although you cannot create new Find Results folders in WebAccess, you can use folders that you created in the GroupWise Windows client. However, to ensure that you are viewing the most recent information in the folder and not a cached copy, you should click Update in the toolbar before opening a Find Results folder.

To see your search results at any time, select the folder.

7.6 Finding Text in Items

In an open item, press Ctrl+F to use your browser’s Find utility. If you need help, consult your browser’s help, which is usually accessed by pressing F1.
You can automate many GroupWise actions, such as replying when you’re out of the office, deleting items, or sorting items into folders, by using rules to define a set of conditions and actions to be performed when an item meets those conditions.

- Section 8.1, “Understanding Rules,” on page 87
- Section 8.2, “Actions a Rule Can Perform,” on page 87
- Section 8.3, “Creating a Rule,” on page 88
- Section 8.4, “Editing a Rule,” on page 91
- Section 8.5, “Deleting a Rule,” on page 92
- Section 8.6, “Enabling or Disabling a Rule,” on page 92

### 8.1 Understanding Rules

When you create a rule, you must do the following:

- Name the rule.
- Select an event. The event is the trigger that starts the rule.
- Select the types of items that will be affected by the rule.
- Add an action. The action is what you want the rule to do when it is triggered.
- Save the rule.
- Make sure that the rule is enabled.

Rules are stored in your GroupWise Mailbox at your post office. Because of this, rules you define in other versions of the GroupWise client also appear in the Rules list and apply when you use GroupWise WebAccess.

You can edit any rules you create in GroupWise WebAccess. If you create rules using another version of the GroupWise client, you can edit those rules if they do not contain more capabilities than GroupWise WebAccess allows you to set. For example, the Windows version of the GroupWise client lets you create rules to apply to items you are sending. Because the Rules feature in GroupWise WebAccess does not include this capability, you cannot edit that rule.

### 8.2 Actions a Rule Can Perform

The following table shows the actions you can perform by setting up rules:

---

**Rules**

87
### 8.3 Creating a Rule

Rules can help you sort your messages, inform others that you’re on vacation, or forward your messages to another e-mail account.

- Section 8.3.1, “Creating a Basic Rule,” on page 88
- Section 8.3.2, “Creating a Vacation Rule or Auto Reply,” on page 89
- Section 8.3.3, “Creating a Rule to Forward All Mail to Another Account,” on page 89
- Section 8.3.4, “Limiting Items Affected by a Rule,” on page 90
- Section 8.3.5, “Using Rule Conditions,” on page 90

#### 8.3.1 Creating a Basic Rule

1. On the main WebAccess page, click Options in the upper right corner.
2. Click Rules.

![Options menu with Rules selected](image)

3. Select the type of rule you want to create.
4. Click Create to display the Create Rule form.
5. Type a name in the Rule name field.

---

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vacation</td>
<td>Sends an automatic reply to the sender of any new items. For example, if you need to be out of the office for several days, your rule could send a reply indicating when you’ll be back. Replies are sent only once per sender.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes or declines any item when the rule conditions are met. For example, your rule could decline any appointment scheduled for a certain day of the week if you are always unavailable for meetings on that day.</td>
</tr>
<tr>
<td>Forward</td>
<td>Forwards items to one or more users when the rule conditions are met. For example, if you are on a core team, you can have a rule forward meeting minutes to extended team members.</td>
</tr>
<tr>
<td>Move to Folder</td>
<td>Moves items to a folder when the rule conditions are met. For example, you might want all items with certain words in the Subject box moved to a common folder.</td>
</tr>
<tr>
<td>Reply</td>
<td>Sends a prepared reply to the sender when the rule conditions are met. For example, if you need to be out of the office for several days, your rule could send a reply to incoming items indicating when you’ll be back. You can also use Define Conditions to prevent replies going to mail list servers and other large groups.</td>
</tr>
</tbody>
</table>
If you want to further restrict the items affected by the rule, select the appropriate options in the Define Optional Conditions section. For more information, see “Understanding Rule Fields” on page 90.

Define the actions you want the rule to perform.
Some actions, such as Move to Folder and Reply, require you to fill in additional information.
Click Save.

For a rule to function, it must be enabled. See “Enabling or Disabling a Rule” on page 92.

### 8.3.2 Creating a Vacation Rule or Auto Reply

1. On the main WebAccess page, click Options in the upper right corner.
2. Click Rules.
3. Select Vacation from the drop-down menu of the Type field, then click Create.
4. Type a name in the Rule name field, such as Vacation Rule.
5. Type a subject, for example:
   Janet is out of the office.
6. Type a message, for example:
   I am out of the office from September 3-September 10. If you need assistance during this time, please contact Martha Robbins at extension 1234.
7. Click Save, verify that the rule has a check mark next to it indicating that it is enabled, then click Close.

### 8.3.3 Creating a Rule to Forward All Mail to Another Account

1. On the main WebAccess page, click Options in the upper right corner.
2. Click Rules.
3. Select Forward from the drop-down menu of the Type field, then click Create.
4. Type a name in the Rule name field, such as Forward Rule.
5. Use Define Optional Conditions to add specific information to your rule.
   - In the first condition field, select To. This tells the rule to check the To: line in each incoming item.
   - In the second condition field, select Matches. This tells the rule that the text in the incoming item's To: line must match the text you type in the next condition field.
   - In the last condition field, type your name as it displays in the To: field of a mail message. For example: msmith@corporate.com.
6. Type the address that you want the items forwarded to in the To field.
7. Type a subject you want to use for forwarded items, for example Fwd:.
8. (Optional) Type a message for all forwarded items.
9. Click Save, verify that the rule has a check mark next to it indicating that it is enabled, then click Close.
8.3.4 Limiting Items Affected by a Rule

Use Define Optional Condition options to further limit the items affected by a rule.

1. On the Rules page, click the first drop-down list, then click a field.
   To learn about what the fields represent, see “Understanding Rule Fields” on page 90.

2. Click the operator drop-down list, then click an operator.
   To learn how to use operators, see “Using Rule Operators” on page 90.

3. Type the criteria for the rule.
   If you type criteria, such as a person’s name or a subject, you can include wildcard characters such as an asterisk (*) or a question mark (?). Text you type is not case-sensitive.
   To learn more about wildcard characters and switches, see “Using Rule Wildcard Characters and Switches” on page 91.

4. Click Save, verify that the rule has a check mark next to it indicating that it is enabled, then click Close.

8.3.5 Using Rule Conditions

There are different conditions you can use in the Define Optional Condition section:

- “Understanding Rule Fields” on page 90
- “Using Rule Operators” on page 90
- “Using Rule Wildcard Characters and Switches” on page 91

Understanding Rule Fields

The following table explains the fields that are available to you when you create a rule:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>This Field Refers to:</th>
<th>Field Criteria Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>The name of a person in the From field of an item.</td>
<td>Specify the From field.</td>
</tr>
<tr>
<td>Message</td>
<td>Text appearing in the Message field of an item.</td>
<td>Type part or all of the Message field.</td>
</tr>
<tr>
<td>Subject</td>
<td>Text appearing in the Subject field of an item.</td>
<td>Specify part or all of the Subject field.</td>
</tr>
<tr>
<td>To</td>
<td>A person’s name appearing in the To field of an item.</td>
<td>Specify a To field name.</td>
</tr>
</tbody>
</table>

Using Rule Operators

The available operators include the following:
Using Rule Wildcard Characters and Switches

These wildcard characters and switches are available in the Define Optional Condition section only when you select certain fields that require you to type additional text.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Example</th>
<th>Result Includes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contains</td>
<td>From Contains Bill</td>
<td>Items where the From field contains “Bill,” such as items from Bill Jones, Bill Smith, and so on.</td>
</tr>
<tr>
<td>Does Not Contain</td>
<td>From Does Not Contain Bill</td>
<td>Items where the From field does not contain “Bill,” such as items from Bill Jones, Bill Smith, and so on.</td>
</tr>
<tr>
<td>Begins With</td>
<td>To Begins With cli</td>
<td>Items where the To field begins with “cli,” such as “Client Group” or “Clive Winters.”</td>
</tr>
<tr>
<td>Matches</td>
<td>Subject Matches customer reports</td>
<td>Items where the Subject field reads “Customer Reports.”</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Wildcard Characters and Switches</th>
<th>What the Find or Rule Will Match</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND, &amp;, or a space</td>
<td>All items that meet two or more conditions. For example, mountain &amp; goat, mountain AND goat, and mountain goat all find items containing the words “mountain” and “goat.”</td>
</tr>
<tr>
<td>OR or</td>
<td></td>
</tr>
<tr>
<td>NOT or !</td>
<td>All items containing one condition but not the other. For example, mountain ! goat and mountain NOT goat both find items containing the word “mountain” but not the word “goat.” Items that contain both are not included.</td>
</tr>
<tr>
<td>*</td>
<td>All text found within quotation marks. For example, “mountain goats” finds all items containing the phrase “mountain goats.” This does not work with documents or document references.</td>
</tr>
<tr>
<td>?</td>
<td>Matches any one character. For example, jo?n finds all items containing the word “john,” “joan,” “join,” and so on.</td>
</tr>
<tr>
<td>*</td>
<td>Matches zero or more characters. For example, mountain* finds all items containing the words “mountain,” “mountains,” “mountainous,” and so on.</td>
</tr>
<tr>
<td>/NOCASE (default)</td>
<td>Items containing a specific word, regardless of case. For example, /NOCASE ZOO finds both “Zoo” and “zoo.”</td>
</tr>
<tr>
<td>/WILDCARD (default)</td>
<td>Items containing the search terms where * and ? are treated as wildcard characters. For example, /WILDCARD jo?n finds “john”, “joan”, and “join.”</td>
</tr>
</tbody>
</table>

8.4 Editing a Rule

1. On the main WebAccess page, click Options in the upper right corner.
2. Click Rules.
3 Click the name of the rule you want to edit.
4 Make changes to the rule.
5 Click Save.

### 8.5 Deleting a Rule

1 On the main WebAccess page, click Options in the upper right corner.
2 Click Rules.
3 Click Delete next to the name of the rule you want to delete.

### 8.6 Enabling or Disabling a Rule

A rule must be enabled before it can be triggered. When you disable a rule, the rule cannot be triggered. However, the rule is still listed in the Rules page so you can enable it when you need it again.

1 On the main WebAccess page, click Options in the upper right corner.
2 Click Rules.
3 In the list of active rules, select a rule to activate it or deactivate it.
   An enabled rule has a check mark in the box.
4 Click Save to save the changes.
Use Proxy to manage another user’s Mailbox and Calendar. Proxy lets you perform various actions, such as reading, accepting, and declining items on behalf of another user, within the restrictions the other user sets.

**IMPORTANT**: You can proxy for a user in a different post office or domain, as long as that person is in the same GroupWise system. You cannot proxy for a user in a different GroupWise system.

- Section 9.1, “Receiving Proxy Rights,” on page 93
- Section 9.2, “Accessing a Mailbox or Calendar as a Proxy,” on page 95

### 9.1 Receiving Proxy Rights

Two steps must be completed before you can act as someone’s proxy.

- Section 9.1.1, “Adding and Removing Proxy Names and Rights in the Mailbox Owner’s Access List,” on page 93
- Section 9.1.2, “Adding and Removing Users in Your Proxy List,” on page 94

When these two steps are complete, you can open your Proxy List and click the name of the person you’re proxying for whenever you need to manage his or her Mailbox or Calendar.

#### 9.1.1 Adding and Removing Proxy Names and Rights in the Mailbox Owner’s Access List

Before you can act as a proxy for someone, that person must give you proxy rights in his or her Access List. As a mailbox owner, you can assign each user different rights to your calendaring and messaging information. For example, if you want to let users view specific information about your appointments when they do a busy search on your Calendar, give them Read access for appointments.

1. On the main WebAccess page, click *Options* in the upper right corner.
2. Click *Proxy Access*.
3. To add a user to the list, click *Add Entry*.
4. Type a user in the Name field or use the Address Book to select a user.
5 Select the rights you want to give to the user.

**Read:** Read items you receive. Proxies cannot see your Contacts folder with this or any other proxy right.

**Write:** Create and send items in your name, including applying your signature (if you have one defined). Assign categories to items, change the subject of items, and perform tasklist options on items.

**Subscribe to my alarms:** Receive the same alarms you receive. Receiving alarms is supported only if the proxy is on the same post office you are.

**Subscribe to my notifications:** Receive notification when you receive items. Receiving notifications is supported only if the proxy is on the same post office you are.

**Modify options/rules/folders:** Change the options in your Mailbox. The proxy can edit any of your Options settings, including the access given to other users. If the proxy also has Mail rights, he or she can create or modify folders.

**Read items marked Private:** Read the items you marked Private. If you don’t give a proxy Private rights, all items marked Private in your Mailbox are hidden from that proxy.

6 Click *Save*.

7 Repeat Step 3 through Step 6 to add each user.

You can select *All User Access* in the Access List and assign rights to all users in the Address Book. For example, if you want all users to have rights to read your mail, you would assign Read rights to All User Access.

8 To delete a user from the Access List, click *Delete User* next to the user’s name.

9 Click *Close*.

### 9.1.2 Adding and Removing Users in Your Proxy List

Before you can act as a proxy for someone, that person must give you proxy rights in his or her Proxy Access List in *Options*, and you must add that person’s name to your Proxy List. The amount of access you have depends on the rights you have been given.

1 On the main WebAccess page, click *Proxy* on the toolbar.

2 To remove a user, select the name, then click *Remove*.

3 To add a user, type the name, then click *Login*. 
The user’s Mailbox is opened. The name of the person for whom you are acting as proxy is displayed at the top of the Folder List.

4 To return to your own Mailbox, click Logout.

Removing a user from your Proxy List does not remove your rights to act as proxy for that user. The user whose Mailbox you access must change your rights in his or her Proxy Access List.

9.2 Accessing a Mailbox or Calendar as a Proxy

Before you can act as a proxy for someone, that person must give you proxy rights in his or her Proxy Access List in Options. The amount of access you have depends on the rights you have been given.

1 If you haven’t already done so, add the username of the person to your Proxy List.
   
   For more information, see “Adding and Removing Users in Your Proxy List” on page 94.

2 On the main WebAccess page or Calendar page, click Proxy on the toolbar.

3 Click the name of the person whose Mailbox you want to access.

4 When you have finished your work in the other person’s Mailbox, click Logout.
RSS is a Web format used to publish frequently updated content such as blog entries, news headlines, or podcasts. An RSS document, which is often called a feed, Web feed, or channel, contains either a summary of content from an associated Web site or the full text. RSS makes it possible for people to keep up with their favorite Web sites in an automated manner that’s easier than checking them manually.

- Section 10.1, “Subscribing to RSS Feeds,” on page 97
- Section 10.2, “Reading RSS Feeds,” on page 97
- Section 10.3, “Deleting an Individual RSS Entry,” on page 97
- Section 10.4, “Deleting a Subscribed RSS Feed,” on page 97

### 10.1 Subscribing to RSS Feeds

When you subscribe to RSS feeds in the GroupWise Windows client, the GroupWise Feeds folder is created. A list of the feeds that you are currently subscribed to is displayed under the GroupWise Feeds folder. You can create subfolders under the GroupWise Feeds folder and move feeds to the subfolder. When you click the subfolder, the message list displays a list of all the topics for all the feeds under the subfolder.

Although you cannot subscribe to new RSS feeds in WebAccess, you can view the feeds you subscribed to and downloaded in the GroupWise Windows client.

### 10.2 Reading RSS Feeds

1. In the GroupWise Feeds folder in the Folder List, click the RSS feed you want to read.
2. Double-click the feed in the Message list to view the feed in a new window.
3. Click View next to the source attachment to see the original URL for the feed.
4. Click the URL to see the original feed.

### 10.3 Deleting an Individual RSS Entry

1. In the GroupWise Feeds folder in the Folder list, click the RSS feed entry you want to delete.
2. Click the Delete icon on the toolbar.

### 10.4 Deleting a Subscribed RSS Feed

1. In the GroupWise Feeds folder in the Folder List, click the RSS feed you want to delete.
2. Right-click the feed to delete, then click Delete Folder.
By using the Documents tab, you can search GroupWise Library documents.

In each library, the documents are compressed and encrypted. This saves disk space and maintains the security of documents because it makes it impossible to view the contents of documents outside of GroupWise.

Before you can access any of the documents in a library, you must first have rights to the library. Your system administrator determines which people have access to each library.

- Section 11.1, “Searching for Documents,” on page 99
- Section 11.2, “Viewing a Document,” on page 99
- Section 11.4, “Saving a Document,” on page 100
- Section 11.5, “Viewing the Properties of a Document,” on page 100

11.1 Searching for Documents

1 Click the Documents tab on the Nav Bar.
2 Type the words you want to search for.
3 Select the field to search.
4 Select the libraries to search.
5 Click Search.

11.2 Viewing a Document

1 Click the Documents tab on the Nav Bar.
2 Search for the document you want to view.
3 Click the document’s name to view the document.

11.3 Opening a Document

1 Click the Documents tab on the Nav Bar.
2 Search for and select the document you want to open.
3 In the Documents list, click Open in the Actions column.
11.4 Saving a Document

1. Click the Documents tab on the Nav Bar.
2. Search for the document you want to save.
3. In the Documents list, click Save As next to the document.
   GroupWise WebAccess gives the item a temporary filename. You can change the filename and default folder.
4. Click Save to save the document in its native format.

11.5 Viewing the Properties of a Document

1. Click the Documents tab on the Nav Bar.
2. Search for the document whose properties you want to view.
3. In the Documents list, click Properties next to the document.
12 Maintaining GroupWise

- Section 12.1, “Managing Mailbox Passwords,” on page 101
- Section 12.2, “Managing Trash,” on page 102
- Section 12.3, “Checking Your WebAccess Version,” on page 103

12.1 Managing Mailbox Passwords

- Section 12.1.1, “Using LDAP Authentication,” on page 101
- Section 12.1.2, “Changing Your LDAP Password,” on page 101
- Section 12.1.3, “Remembering Your GroupWise or LDAP Password,” on page 101
- Section 12.1.4, “Using Mailbox Passwords with Proxies,” on page 102

12.1.1 Using LDAP Authentication

If your system administrator has turned on LDAP authentication, your LDAP password is used to access your Mailbox instead of a GroupWise password. With LDAP authentication, you are required to have a password and you cannot remove your password.

12.1.2 Changing Your LDAP Password

If your system administrator has turned on LDAP authentication and has disabled changing your LDAP password in GroupWise WebAccess, you might need to use a different application to change your password. Contact your system administrator for more information.

1. On the main WebAccess page, click Options in the upper right corner.
2. Click the Password tab.
3. In the old password field, type the password you want to change.
4. In the new password field, type the new password.
5. In the Confirm field, type the new password again, then click Save.

When you change your password in GroupWise WebAccess, you change it for your GroupWise Mailbox. That means that you always use the same password to log in to your GroupWise Mailbox whether you are using GroupWise WebAccess or another version of the GroupWise client.

12.1.3 Remembering Your GroupWise or LDAP Password

If you have a password but do not want to be prompted for it every time you start GroupWise WebAccess, you can rely on your Web browser to remember your password for you. However, for security reasons, we don’t recommend having your browser store both your GroupWise username and password.
12.1.4 Using Mailbox Passwords with Proxies

Setting a password for your Mailbox does not affect a proxy’s ability to access your Mailbox. A proxy’s ability to access your Mailbox is determined by the rights you assign him or her in your Access List.

12.2 Managing Trash

All deleted mail and phone messages, appointments, tasks, documents, and reminder notes are stored in the Trash. Items in the Trash can be viewed, opened, or returned to your Mailbox until the Trash is emptied. (Emptying the Trash removes items in the Trash from the system.)

You can empty your entire Trash, or empty only selected items. Items in the Trash are emptied according to the way your GroupWise administrator specifies, or you can empty the Trash manually. The system administrator can specify that your Trash is emptied automatically on a regular basis.

- Section 12.2.1, “Displaying Items in Your Trash,” on page 102
- Section 12.2.2, “Undeleting an Item in Your Trash,” on page 102
- Section 12.2.3, “Saving an Item In Your Trash,” on page 102
- Section 12.2.4, “Emptying the Trash,” on page 103

12.2.1 Displaying Items in Your Trash

1. In your Mailbox, click the Trash folder.

You can open, save, and view information on items in the Trash. You can also permanently remove items or return them to the Mailbox. Right-click an item in the Trash to see more options.

12.2.2 Undeleting an Item in Your Trash

The GroupWise Windows client includes an option for automatically emptying the Trash after a specified number of days. If this option has been set, either by you or by the GroupWise system administrator, items in the Trash are automatically purged after the specified number of days and you won’t see them in the GroupWise WebAccess client.

To undelete items from your Trash folder:

1. Click the Trash folder.

2. Select the item, then click Undelete at the top of the Item List.

   or

   Double-click the item to open it, then click Undelete.

The undeleted item is placed in the folder from which it was originally deleted. If the original folder no longer exists, the item is placed in your Mailbox.

12.2.3 Saving an Item In Your Trash

You can save items that are in the Trash the same way you would save any other item. For more information, see Section 3.4.1, “Saving an Item to Disk,” on page 46 for more information.
12.2.4 Emptying the Trash

To empty all the items from the Trash:

1. In your Mailbox, right-click the Trash folder, then click Empty Trash.

To empty specific items from the Trash:

1. In your Mailbox, click the Trash folder.
2. Select one or more items.
3. Click Purge.

12.3 Checking Your WebAccess Version

You view WebAccess system information by clicking Novell GroupWise WebAccess on the upper left of the page. This provides version information, the user ID, and browser information. This information is necessary when contacting Support for help.
Welcome to the GroupWise 8 WebAccess client. You’ll find new features, a fresh user interface, and significant updates. The following list is an overview of the new features in GroupWise 8:

- Section A.1, “Improved Interface,” on page 105
- Section A.2, “New Folder Types,” on page 105
- Section A.3, “E-Mail Improvements,” on page 106
- Section A.4, “Calendar Improvements,” on page 106
- Section A.5, “Search Improvements,” on page 106
- Section A.6, “Tasklist,” on page 106
- Section A.7, “Contacts Folder,” on page 107

A.1 Improved Interface

The GroupWise 8 WebAccess client has been improved with an updated look and feel, more customizable user interface, more attractive buttons and icons, and many other changes. The main improvements include:

- **Scrollable Item Lists**: Your message list now contains all items in your Mailbox, rather than displaying only 20 items at a time.
- **Time Zone Synchronization with Your Workstation**: When you change the time zone on your workstation, GroupWise WebAccess automatically switches its time to match the workstation without restarting WebAccess, or you can specify to use a selected time zone.

A.2 New Folder Types

New folder types give you access to more kinds of information and the ability to better organize your GroupWise items.

- **RSS Feeds Folder**: In this release, the GroupWise 8 Windows client allows you to subscribe to RSS feeds. If you use the Windows client to subscribe to feeds, you can read the feeds in the GroupWise WebAccess client, after the Windows client has downloaded the feeds. When you subscribe to RSS feeds, the feeds are displayed in the RSS folder. See “GroupWise Feeds Folder” on page 17 and Section 10, “RSS Feeds,” on page 97.
- **Tasklist Folder**: The new Tasklist folder replaces and expands upon the old Checklist folder. You can move any items (mail messages, phone messages, reminder notes, tasks, or appointments) to this folder and arrange them in the order you want. Each item is marked with a check box so that you can check off items as you complete them. See Section 5.2, “Understanding the Tasklist Folder,” on page 63.
A.3 E-Mail Improvements

- **Auto Save:** GroupWise WebAccess automatically saves a copy of the item you are composing every 10-60 seconds. This is helpful if GroupWise stops unexpectedly. When you restart WebAccess, you are prompted with recovery options for the items. See “Understanding Auto-Save” on page 34.

- **HTML Options:** You can choose to view and compose messages in either Plain Text or HTML format. In the HTML format, you can quickly change fonts, sizes, and colors and add bulleted and numbered lists. See Section 3.1.1, “Composing E-Mail,” on page 30.

- **Spell Check:** GroupWise WebAccess uses a new spell checker that highlights all the misspelled words in your subject or message fields. You can choose to automatically check each message you create before you send it.

- **Name Completion:** When addressing a new mail message, the system automatically searches for a name when you begin to type. As you type, the remainder of the name fills in for you. This feature uses your contacts and address book to help you quickly find a name.

A.4 Calendar Improvements

Several calendar enhancements have been made to the GroupWise 8 WebAccess client. Some of the key improvements include:

- **Graphical Calendar Interface:** Calendars display in a way that allows you to choose a Day, Week, or Year view. You can also quickly add appointments, notes, and tasks in your Calendar and see a summary view of an item by mousing over that item.

- **Multiple Personal Calendars:** You can now create one or more personal calendars, in addition to the main GroupWise Calendar. See Section 4.2.3, “Creating a Personal Calendar,” on page 52.

- **Aggregated Shared Calendars:** Now you can select to display shared calendars in your main calendar view and select a different color for each calendar. See “Selecting Calendars to Display” on page 51.

- **Publishing Internet Calendars:** You can select to publish any personal calendar to the Internet. When you select to publish a personal calendar to the Internet, it is copied to the Calendar Publishing Host server. You can select the time period of the content to publish as well as what to publish, from just free/busy information to your entire calendar. See Section 4.5, “Publishing Personal Calendars on the Internet,” on page 59.

A.5 Search Improvements

- **Date Range:** You can search according to the date a message was created or delivered. See Section 7.3, “Searching with Criteria,” on page 84.

- **Category:** You can search according to the category of a message. See Section 7.3, “Searching with Criteria,” on page 84.

A.6 Tasklist

The GroupWise Checklist feature has been renamed the Tasklist. Tasklist items can be found in the Tasklist folder, but can also be placed in other folders, including the Mailbox and Calendar. For more information, see Chapter 5, “Tasks and the Tasklist,” on page 63.
A.7 Contacts Folder

The Contacts folder displays a list of all personal address books for quicker access to your personal address books. It also includes a new QuickViewer option where you can quickly view and edit details for a selected contact.
GroupWise Frequently Asked Questions

The GroupWise 8 Client Frequently Asked Questions (FAQ) (http://www.novell.com/documentation/gw8/gw8_userfaq/data/gw8_userfaq.html) is intended to help GroupWise client users who have not found the information they need in the GroupWise client online help or User Guides.

- How Do I Find What I Need in the GroupWise Client Documentation (http://www.novell.com/documentation/gw8/gw8_userfaq/data/gw8_userfaq.html#userfaq_howdoi)
- GroupWise Windows Client FAQ (http://www.novell.com/documentation/gw8/gw8_userfaq/data/gw8_userfaq.html#userfaq_windows)
- GroupWise Linux/Mac Client FAQ (http://www.novell.com/documentation/gw8/gw8_userfaq/data/gw8_userfaq.html#userfaq_linmac)
- GroupWise WebAccess Client FAQ (http://www.novell.com/documentation/gw8/gw8_userfaq/data/gw8_userfaq.html#userfaq_webaccess)
- Non-GroupWise Clients FAQ (http://www.novell.com/documentation/gw8/gw8_userfaq/data/gw8_userfaq.html#userfaq_nongwclients)
- GroupWise Client Comparison (http://www.novell.com/documentation/gw8/gw8_userfaq/data/gw8_userfaq.html#userfaq_comparison)
- Where Do I Go for More Help? (http://www.novell.com/documentation/gw8/gw8_userfaq/data/gw8_userfaq.html#userfaq_morehelp)
You can use a number of shortcut keys in GroupWise WebAccess for accessibility or to save time when you perform various operations. The table below lists some of these keystrokes, what they do, and the context where they work.

**Table C-1  Shortcut Keys**

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Action</th>
<th>Where It Works</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+A</td>
<td>Select all items; select all text</td>
<td>Item List; text</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy selected text</td>
<td>In text</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>Open the Find window</td>
<td>Main WebAccess page, Calendar, item</td>
</tr>
<tr>
<td>Ctrl+M</td>
<td>Open a new mail message</td>
<td>Main WebAccess page, Calendar, item</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Open the Print dialog box</td>
<td>Main WebAccess page, item</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Paste selected text</td>
<td>In text</td>
</tr>
<tr>
<td>Ctrl+X</td>
<td>Cut selected text</td>
<td>In text</td>
</tr>
<tr>
<td>Ctrl+Z</td>
<td>Undo the last action</td>
<td>In text</td>
</tr>
<tr>
<td>Enter</td>
<td>Open the selected item</td>
<td>Item List</td>
</tr>
<tr>
<td>Del</td>
<td>Delete an item</td>
<td>In an item</td>
</tr>
<tr>
<td>Ctrl+Up-arrow</td>
<td>Scroll to the previous or next item</td>
<td>Main WebAccess page</td>
</tr>
<tr>
<td>Ctrl+Down-arrow</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ctrl+Shift+Left-arrow</td>
<td>Select text one word at a time</td>
<td>In text</td>
</tr>
<tr>
<td>Ctrl+Shift+Right-arrow</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alt+F4</td>
<td>On the main WebAccess page or Calendar page, exit GroupWise WebAccess.</td>
<td>Main WebAccess page, Calendar, item</td>
</tr>
<tr>
<td></td>
<td>In an item, exit the item.</td>
<td></td>
</tr>
<tr>
<td>Alt + [letter]</td>
<td>Activate the menu bar (Use the underlined letters in the menu names)</td>
<td>Main WebAccess page, Calendar, item</td>
</tr>
<tr>
<td>Keystroke</td>
<td>Action</td>
<td>Where It Works</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Shift+Left-arrow</td>
<td>Select text one character at a time</td>
<td>In text</td>
</tr>
<tr>
<td>or</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shift+Right-arrow</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shift+End</td>
<td>Select text to the end or beginning of a line</td>
<td>In text</td>
</tr>
<tr>
<td>or</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shift+Home</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tab</td>
<td>Cycle through fields, buttons, and areas</td>
<td>Main WebAccess page, Calendar, item</td>
</tr>
<tr>
<td>Shift+Tab</td>
<td>Reverse the order of cycling through fields, buttons, and areas</td>
<td>Main WebAccess page, Calendar, item</td>
</tr>
</tbody>
</table>
This section lists updates to the GroupWise 8 WebAccess Client User Guide that have been made since the initial release of GroupWise 8. This information helps you keep current on documentation updates and, in some cases, software updates (such as a Support Pack release).

The information is grouped according to the date when the GroupWise 8 WebAccess Client User Guide was republished.

The GroupWise 8 WebAccess Client User Guide has been updated on the following dates:

- Section D.1, “July 14, 2010 (GroupWise 8 SP2),” on page 113

### D.1 July 14, 2010 (GroupWise 8 SP2)

<table>
<thead>
<tr>
<th>Location</th>
<th>Updates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section 7.3, “Searching with Criteria,” on page 84</td>
<td>Explained the new date range and category filters for the WebAccess Find feature.</td>
</tr>
</tbody>
</table>